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Introduction
Simeon Mail is an electronic mail (email) software package which enables people to 
communicate with one another from their personal workstation. Simeon Mail provides you with a 
highly effective tool for creating, organizing, sending and receiving messages. These messages 
may be "anything which can be represented electronically". This may include text, word 
processing documents, spreadsheets, graphics, sound or video.



What is Electronic Mail?
Today, more and more computers are not sitting isolated but, instead, are connected into a 
computer network which is often connected to other computer networks in much the same way as
telephone systems connect telephones. If your computer is connected to such a network, you can
use email to communicate with people whose computers are connected to the same network. You
are no longer limited to your Local Area Network but, in effect, have the world at your fingertips 
through the Internet. The Internet is a world-wide network connecting tens of thousands of Local 
Area Networks.

Electronic mail replaces paper memos at the office with electronic mail memos. Reports, letters, 
spreadsheets, anything generated on your computer can be sent through email, rather than on 
paper or diskette, around the office or around the world. Electronic mail allows this transfer of 
information to be done more easily and more cost effectively. Email messages are sent in a 
fraction of the time of regular mail and at a fraction of the cost of mail sent by courier.



Electronic Mail Addresses
As with regular post, electronic mail requires addresses. These addresses consist of two parts: a 
user name and a mail domain (sometimes called a domain name). The user name identifies a 
particular person. It may be their full name or an identification code, but is more likely a shorthand
form of their name. The mail domain identifies the place on the Internet where the email for that 
person should be sent.

When writing electronic mail addresses the user name and mail domain are separated by the "at" 
symbol ("@"). For instance, to send email to Joe Doe at ABC Company the address could be:

jdoe@abc.ca

jdoe defines his user name as he is known on his system and @abc.ca defines the mail 
domain. 

Note:    The mail domain can be left out of the address if you are sending mail to someone using 
the same mail domain as you.



Types of Messages
You may send and receive messages in various formats. In most cases messages will be 
received as plain text. That is, the message sender has typed a message and sent it to your email
address.

Other messages may contain attachments. These attachments can be files from other programs 
that can operate on your computer. These files may range from Microsoft Word documents to 
Lotus spreadsheets to image files.



What Do I Need to Know?
Simeon Mail uses standard functions to access the various features available. No additional 
special knowledge is required. Should any questions arise there is an on-line HELP facility and 
the User Guide for reference.

This guide assumes that Simeon Mail is already installed and properly configured for your 
installation. It also assumes that you have a working knowledge of computers.



Conventions Used in this Guide
Many of the functions in Simeon Mail are available through the use of button icons on a toolbar. 
Although all functions are available using both the toolbar and the menu system, in most cases 
they are explained using the button icons. To help with your familiarity in the menu system 
available with Simeon Mail, however, some functions have been explained using both the menu 
system and toolbar.

More:
Typographic Conventions
Keyboard Conventions
Mouse Conventions



Typographic Conventions
The following kinds of formatting in the text of this guide have been used to identify special 
information.

Formatting Convention Type of Information 

Bold Italic type Indicates choices to be made from the drop down menus. For example, if
this manual instructs you on how to create a new folder it would say 
"...select Folder... from the File/New menu"

Helvetica Bold Font Indicates the name of a button on the toolbar. An example would be the 
guide instructing you on how to delete a message by stating "... and click 
on the Del button".

Monospace Font Examples of command lines that can be used to launch Simeon or 
Newsgroup names are indicated in a monospace font.

Italic Font Specific names of message services, folders and message groups are 
indicated in italic font. For instance, this guide will indicate the name of a 
message group as "the Deleted message group".



Keyboard Conventions
All key names are shown in small capital letters. For instance, the Control key is CTRL and the 
enter or return key is ENTER.

Key Comments

Shortcut keys There are a number of keys that can be used in Simeon Mail as 
keyboard shortcuts. For example, to send a message you may use the 
Send button, select Send from the Compose menu or use the shortcut 
key CTRL S. Each shortcut key available is indicated by its menu 
selection in a drop down menu and is also included in this guide as 
Appendix A.

Arrow keys Once an object such as a message in a message group has been 
selected, you can use the UP ARROW, DOWN ARROW, PAGE UP and PAGE 
DOWN keys to move to a different selected object.

A full list of shortcut keys and keyboard navigation available is in Shortcut Keys.



Mouse Conventions
You may use any conventional mouse available with your personal computer for Simeon Mail. 
Simeon Mail supports the use of the right mouse button. Depending on your location the right 
mouse button will show a menu of available items for the object selected. In this guide the 
following terms are used to indicate the actions taken with the left mouse button.

· "Click" means to press and then immediately release the mouse button without moving the 
mouse.

· "Drag" means to point and then hold down the mouse button as you move the mouse to the 
desired location on your screen.

· "Select" is used to indicate a menu selection that must be made. This means to Click on the 
stated menu and move the mouse pointer to the selection stated and click again.



Objects
Throughout this guide references are made to objects. Objects in Simeon are the actual 
messages received or the message groups, folders, sub-folders, search folders or message 
services that serve as the organization of Simeon Mail in the Message Organizer. Addressbook 
Organizer objects consist of individual addresses, lists, address books and address book 
searches.

More:
Deleting Objects
Deselecting an Object



Deleting Objects
Objects may be deleted using either the Del button on the toolbar or through the File menu by 
selecting Delete. You will not be allowed to delete objects such as the inbox folder or the Main 
and Deleted message groups.    You will be allowed to delete the Post Office message service, 
however, this is not recommended as this message service receives all your new mail.



Deselecting an Object
To deselect an object hold down the CTRL key and click on the selected object.



Expanding and Collapsing
Expanding allows you to view the contents of 
an object such as message service, folder or 
message group. Any object that can be 
expanded has a plus (+) sign to the left. Click 
on the plus sign to expand the object. 
If an object has been expanded a minus sign 
(-) will appear. To collapse an object click on 
the minus sign to the left of the object.

Closing vs. Collapsing
Objects may be expanded and collapsed as stated above but expanded message services or 
folders may also be opened into their own window.    This is accomplished by using one of three 
methods; double clicking on the message service or folder name, selecting the message service 
or folder and ENTER key or, with the appropriate object selected choosing Open from the    File 
menu. This can be done on any message service or folder and may help you in manipulating mail
by making the contents more visible.

When you open a message service or folder 
into its own window you will notice that the 
associated icon will be grayed out, this 
indicates that the object has been opened. To 
close the open window, double click on the 
Control Menu button found in the upper-right 
corner of the opened window or select Close 
from the File menu.

More:
Closing a Message Service or Folder



Closing a Message Service or Folder
To close a message service or a folder and all 
messages contained in them, choose Close 
from the Folder menu. Simeon will prompt 
you asking if you are sure you wish to close 
the message service or folder and all objects 
contained in it. 

The next time that message service or folder is accessed, whether expanding or opening into its 
own window, it will open the appropriate folders and add all messages to the message groups 
contained in that folder before it is expanded or opened. Closed message services are grayed 
Post Office icons while open message services have a flag.    Folder icons graphically represent 
file folders.



Count Down
Whenever Simeon Mail is busy the hand in the top
left corner will count down. This indicates that 
Simeon Mail is too busy to take on additional 
tasks.

Available Functions
Each time an object is selected, the toolbar will display or highlight only those functions that are 
available. For instance, if no objects are selected only Compose and Addr (Address Book) are 
available.    If you have selected a folder, Del (Delete), Clean and Info also become available. The 
same principle holds true for the menus with unavailable options appearing grayed and available 
options appearing black.    The available menu options will change in relation to the active 
window.    For example, active windows are indicated by a colored title bar and all available 
options related to that window are in dark text.    Inactive menu and toolbar options are activated 
by selecting the related window or feature.



Introduction
Simeon Mail is a simple and intuitive user interface. This chapter deals with the conventions used 
in Simeon Mail and explains the overall organization of the software.



Starting Simeon Mail
Simeon Mail is started by either double clicking 
the mouse on the Simeon Mail icon in the 
Microsoft Windows group that contains the icon 
or by including Simeon Mail in your startup 
group.

Saving Your Logon Throughout Session
Each time you access a different function of Simeon Mail, such as the Post Office or News Stand 
message services or Address Books, you will be asked for your user name and password.    By 
checking the box "Use Login as Session Default"  when you first log in, you will only need to type 
this information once. Simeon Mail will access this logon information each time it accesses a new 
area. If you close a message service you have logged on to, you will not have to re-enter your 
name and password if this box has been selected.

Note    If you will be accessing another user's messages through a message service set up in 
your Simeon Mail configuration, you should not select the "Use Login as Session Default" as it will
logon to each messages service using your userid.



Organization of Simeon Mail
There are three key objects provided by Simeon Mail to help you organize your mail. These are:

· Message Services
· Folders
· Message Groups

Each of these objects allows you to better receive and organize messages by allowing you to 
direct specific messages into specific areas where they can be displayed and managed together. 
The following outlines the order of these objects and their associated icons:

Figure 1 Overview of Simeon Mail Organization

More:
Message Services
Folders
Message Groups



Message Services
Message services act as receiving houses for all messages. Each message is first routed through
a message service before it is further classified. There are three system-specified message 
services initially set up with Simeon Mail: Post Office, News Stand and Local Folders.

Post Office is where regular messages addressed to you are sent. News Stand contains 
messages sent to the network newsgroups to which you may subscribe. The Local Folders 
message service resides on your workstation and may be used as a repository for messages that
have been received. Local Folders is also used for offline operation.



Folders
Each message service contains folders where messages are stored.

To view the folders contained in the Post 
Office message service click on the plus 
sign to the left of the message service. This 
icon indicates an expanded message 
service. Double clicking on the icon will 
open the message service in a separate 
window.

An expanded message service will show the various folders contained within it. While these 
folders may be user-specific, Simeon Mail has one system-specified folder. The inbox folder is the
folder designated to initially receive all messages sent specifically to you.

In addition to the inbox folder, three additional default folders have been set up in the Local 
Folders message service. These are: drafts for incomplete messages, outbox for holding all 
queued mail, and sentmail for storing copies of any messages that have been mailed.    These 
folders will not be created until you have actually requested a message be saved to one. The 
specific locations of these folders are set under Tools/Options/Edit. For more information on 
creating or changing these folder locations or names please refer to Send Options for the outbox 
folder and Compose Options for drafts and sentmail folders.

You may create other Post Office folders to hold messages that have been archived or deal with 
different projects. Individual News Stand folders will contain messages from a single newsgroup. 
Information on creating new folders can be found in Creating a New Folder.

To expand the folder in Post Office, click on the plus sign that corresponds with the folder. This 
will display the list of sub-folders or message groups contained in that folder. 



Message Groups
Folders are initially divided into two message groups, Main and Deleted.    Remember that you 
must have selected View Message Groups under Folder menu for these groups to be visible.    
The Main message group contains all messages received by you that have not been specifically 
routed into another message group. Deleted contains all messages deleted by you until they are 
permanently cleaned from Simeon Mail or undeleted.    Simeon Mail also enables you to create 
any number of message groups to assist in the sorting of your incoming mail. More information on
creating message groups can be found in Creating a Message Group.

When viewing the message groups, Simeon Mail will inform you of the number of messages in 
each group and the status of those messages. Message groups will display similar to that shown 
below:

Figure 2 Viewing Message Groups

If you are using Simeon Mail for the first time or have recently upgraded to a newer version of 
Simeon, you will notice that all message groups are absent.    The window arrangement will be 
similar to the one shown below:

Figure 3 Hiding Message Groups

Each folder can individually display the message groups contained within it. To view your 
messages in message groups:

1. select the folder where you wish to view the message groups;

2. select View Message Groups under the Folder menu.

If you are upgrading you will notice that all groups which were created in a previous version will 
be shown, including those that are empty.    Again, accessing the messages in a specific group is 
done by clicking on the plus (+) sign to the left of the message group to expand that group.



Column Manager
Simeon Mail provides you with various pieces of information regarding the contents of each 
object displayed. For instance, a folder will graphically display a folder icon and provide the folder 
name such as inbox and message groups provide you with the group name and the number of 
read and unread messages.

You will notice in Simeon that each time you select one of these objects the Column Manager, 
located below the title bar, changes to reflect the information available for the object that has 
been selected.    Each component of Simeon Mail can be customized to suit your specific needs.   
All columns may be resized, reordered or simply turned off.    To toggle the Column Manager on or
off, from the View menu select Column Manager.    A sample Column Manager for messages is 
shown below.    Along with this sample is a description of the features of the Column Manager.

Figure 4 Column Manager

More:
Manager Button
Reordering Columns
Resizing Columns



Manager Button
The Manager Button on the right side of the Column 
Manager bar is used to delete, undelete and resize 
columns. Select a message and click on this button 
to bring up the following window.

Figure 5 Manager Window

The Manager window will provide the names of the columns available for the object that was 
selected, in this case a message. Columns currently being viewed are indicated with a check 
mark beside the column name. Click in this box to deselect that column from the window. Click 
again to insert it back into the Column Manager. When a column name has been highlighted you 
will be able to change its size.



Reordering Columns
Reordering columns is done using the Column Manager. To reorder the columns first select the 
column you wish to move. Selecting again and dragging the column to the new location will 
reorder your columns.



Resizing Columns
Columns may be resized either through the Manager window or directly on the Column Manager. 
To resize through the Manager window click on the Manager button to the right of the Column 
Manager bar, select a column and resize by either clicking on the up and down arrows in the size 
box or directly inputting a new size. Clicking the Apply button will change the column size.

To resize directly from the Column Manager place your mouse arrow any border of the column 
you wish to resize. Holding down the mouse button so a vertical bar will appear you can then 
drag the bar to either increase or decrease the column width.    



Status of Mail
Simeon Mail graphically indicates the status of your mail to the left of each message. 

Indicates a new mail message.

Indicates mail that is received but unopened.

Indicates mail that has been opened.

An unopened box with a flash indicates a new 
message that contains attachments.
If an unopened message contains an attachment a box
representing that attachment will replace the 
envelope.
If a message containing an attachment has been 
opened, an opened box will indicate this. This does not
indicate that the attachment itself has been opened or
read. 
This icon indicates that the message is in draft form. 
Upon double clicking the contents will automatically be
placed in a Restart Compose window.

On deleting a message the icon is marked with an "X" 
to indicate that you have deleted the message.    If you
have selected View Message Groups under the Folder
menu, the message will appear in your Deleted 
Message Group.

In addition to the open or closed envelopes or boxes, Simeon Mail will indicate if a message has 
been replied to by placing an "R" next to the message or you can mark the message as special 
by placing an asterisk ("*") beside the icon. For further information on marking messages replied 
or special please see Changing the Status of a Message.



New Mail Notification
Each time you receive new mail Simeon will indicate this in one of two ways. If Simeon is full 
screen you will hear a beep when new mail is received and the message group receiving the mail
will indicate an additional unread message.

If Simeon is minimized, in addition to the beep, the 
Simeon hand will be holding an envelope. After you 
have read the message and Simeon is again 
minimized, you will notice the icon has changed 
back.

Drag and Drop
Simeon Mail provides a drag and drop facility for moving or copying messages between folders, 
reorganizing the order of your message groups and folders, or copying addresses from one 
Address Book to another. It will be discussed throughout the guide as valid drop locations 
become available.



Exiting from Simeon Mail
You can exit from Simeon Mail using standard Windows procedures by either double clicking on 
the Control Menu in the top left corner or selecting Exit from the File menu. You may cancel the 
exit at this point.    If you select OK, Simeon Mail will prompt you regarding the disposition of the 
Deleted message group asking you to decide to keep the Deleted message group intact or 
physically delete the messages in this group.



Changing Your Password in Simeon
You can change your login password from within Simeon Mail if your site administrator has 
enabled this option. This option can be very useful when you are logging on to a foreign network.  
To perform this operation follow these steps:

1. Select Change Password from the Tools menu.

2. Specify your hostname and port then your userid and password.

3. Select Login if you wish to change your password or Cancel if you would like to discontinue 
the operation.

4. Type in your new password and confirm your password.

5. Select Change Password.    Again, if you would like to discontinue the operation select Cancel.

On opening your Post Office, other Message services or Address Books you will be prompted 
again to login using your new password.    By checking the box "Use Login as Session Default"  
when logging in you will only need to type this information once.



Simeon Mail Layout
Regardless of the method of access, when you initially start Simeon Mail you will have a generic 
window layout. As you work through Simeon Mail you will develop a layout for your folders and 
message groups that you find comfortable to work with. This may involve having certain message
groups expanded or placing specific folders into their own windows. Upon exiting Simeon Mail 
this setup will be saved allowing you to re-enter with exactly the same layout as when you exited.

Note    If you don't want your current desktop setup saved deselect Save Desktop on Exit  from 
the Tools/Options menu. This will allow Simeon to load the same configuration in your Message 
Organizer every time to log in.



Information
At any time you may request information 
regarding any object in Simeon Mail. For instance, 
to receive information regarding a specific 
message click on the message then click on the 
Info button on the toolbar or Properties in the 
File menu.    Please see the example below:

Figure 6 Message Properties Window

This window supplies information on the specific message and contains the message service and
folder that contain the message, the sender, subject, type and size in bytes of the message. It will
also provide the status of the message, viewed, replied, special, or deleted, or whether the 
message is multipart (i.e. it contains attachments). You may change the status of the message 
from the Ppoperties window if you wish. Clicking on OK will make these changes and remove the 
window from your screen. Clicking on Cancel will remove the window from your screen without 
any changes.

For more information on the Replied and Special status please refer to Changing the Status of a 
Message.

Note:    Properties can also be accessed through a right mouse button menu available for each 
object. 



Introduction
This section is designed to assist you in setting up your own environment and default settings.    
The amount of time spent in setting up your default option can provide you with great returns in 
the long-run.

Options are used to configure your specific environment to accept certain defaults. These defaults
may be anything from the signature lines automatically included in any message to the types of 
attachments you frequently access.

Each preference is accessed through the Tools menu by selecting Options/Edit. Once this is 
selected, the following window will appear on your computer allowing you to select either:    User, 
Helper Applications, Fonts, Message Organizer, Compose, Editor, Reply, Forward, Send, 
View, Address, or Logging Options.

Figure 7 Options Window

To select a specific option, click on the appropriate icon at the left of the window.    All panels allow
you to either go back to the original, cancel, or accept the changes that have been made. 
Selecting Back will return the panel to the last saved state.    Selecting the Cancel button will exit 
the panel without saving any changes.    Pressing the OK button will exit and save all changes 
made during the session.



User Options
User options, accessed by clicking the User icon in the Tools/Options /Edit window, allows you 
to select the information that is entered into the signature lines included in any composed 
message. User Options also determine the name and e-mail address used in the header of a 
message. Selecting User from the Tools/Options/Edit window will display the following window, 
allowing you to customize your signature for outgoing messages.

Figure 8 User Options Window

If not already done, you should insert your name and email address as it should appear in the 
header of a message. You may then elect to add information for the signature or closing of any 
message. This information may again include your name and e-mail address as well as phone 
and fax numbers, addresses or any other information you may wish to automatically relay to 
addressees.

By default the Reply-To field will contain your email address. If you continually send email were 
the replies should be sent to a different email address you may insert that address in this field. 

If you enable the option "Save userid and password to File" each time you log into Simeon Mail it 
will bypass the logon window that requests your user name and password. While this option is 
available it is discouraged since both your user name and password will be saved as text in your 
simeon.ini file.



Helper Applications Options
Any message sent or received by Simeon may contain one or more different attachments.    To 
avoid any misinterpretation of information the format of these attachments must be relayed to the 
receiver. The use of standards is one solution to solving a potential disruption in communication.   
The standards Simeon uses and how they can be manipulated are discussed in the following 
sections.    If you are interested in additional information on the communication standard used by 
Simeon Mail, refer to Communication Protocol of this guide.

Figure 9 Helper Applications Window

Below is a general description on the function of each field to be defined for a new Helper 
Application:

· Name of Viewer:    The name should be descriptive of the application and easily identifiable.   
This field also serves to rename or delete a Viewer.

· View with:    This is the location of the application executable used to view the specified 
attachment.    This is similar to defining an Association in Windows.    Also, a browse feature is
provided for ease of locating the executable file. 

· Attachment types:    These are specified using MIME-content types and subtypes (see 
Communication Protocol).    The purpose of the types and subtypes are to describe the nature
of the information contained in the file.    On receipt of a MIME-described file, Simeon Mail 
identifies the format of the file and selects the appropriate application for viewing.

· File Extensions for the Selected Attachment:    As in PC extensions these are three 
characters long and indicate the type of information a file contains. They are not preceded by 
a period.    This may seem redundant, considering the content types and subtypes, but 
extensions are not standard among all platforms.

More:



Helper Application Types
Adding New Helper Applications



Helper Application Types
The Helper Applications window allows you to set up how attachments to messages are sent and 
viewed. There are seven main types of attachments. The following list states the category of each
attachment and an example of what may be included in that category:

· Text: files created with notepad or emacs (called ascii files because they contain only letters, 
numbers and punctuation)

· Multipart: an attachment that contains more than one type of file (generally not used)

· Message: when forward mail including the original Simeon Mail message as an attachment

· Application: any binary file created by Word2, Word6, Lotus 1-2-3 or like application, plus 
other types of binary files such as programs

· Audio: an audio file capable of running on your system

· Image: .tif, .pda, .ras, .pcx, .gif, .jpeg, .bmp

· Video: a video file capable of running on your system

Remember that to view an attachment the application that displays the attachment must be 
resident on your computer or you must have access to it through your network (e.g. you must 
have WordPerfect in order to view a WordPerfect attachment or some sort of sound player to 
listen to an audio file).



Adding New Helper Applications
This section gives an example of the steps used to add a new Helper Application. 

1. Access the Helper Applications window by selecting Edit from the Tools/Options menu and 
click on the Helper Applications icon.

2. In the Helper Applications window click on the Add Viewer... button.

3. In the Helper Application Name field, choose the name you wish to call the new Viewer.    In 
the case below, the Viewer name is Word7.

4. The View with box states the location of the software to start the specific application. If you 
are unsure of the location, the Browse button will allow you to access your system hard drive 
and network to locate the appropriate executable.

5. The Attachment Types field contains the content type and subtype.    In the example, 
"Microsoft Word" has the type Application and the subtype is msword.    Multiple subtypes 
can be used and represent the various formats that may be viewed using the application.

6. File Extensions for the Selected Attachment is the same as the file extensions associated 
with the document itself and reflects the content types and subtypes selected, in this case 
doc.    The file extension(s) need not exactly match the subtype. For instance, if you receive a
WordPerfect file with the extension wpf but do not have WordPerfect on your system, you 
may elect to load it into Microsoft Word. In this case you would need to add wpf as a file 
extension.

An example of this Helper Application setup is in the window below:

Figure 10 Helper Applications Options with New Attachment Type



Font Options
By accessing the Tools/Options/Edit menu and clicking the Fonts icon, you are able to 
customize the fonts used in any area of Simeon Mail. For instance, you may have a different font 
for folder names than you have for message groups or the Address Book names.    Clicking on 
Fonts in the Options window brings up the following window allowing you to select the area, font 
and font effects. Fonts also allows you to set the color of your priority mail.

Figure 11 Font Options Window

In the example above, the area selected to be modified is the Address Book name. The font 
chosen was black, 10 point, "MS Sans Serif" and an example of the effect is displayed below the 
Format box.

The steps to modify a font in an area of Simeon Mail are:

1. Select the area you wish to modify from the pulldown menu (e.g. in the figure above Address 
Book) .

2. Choose from a variety of font types, styles, colors, and sizes.

3. Click on the OK button to exit and accept the changes.    If you wish to modify fonts in more 
than one area of Simeon Mail do not select OK until you have completed all your 
modifications.



Message Organizer Options
Selecting Message Organizer from the Options window, under the Tools/Options/Edit menu, 
accesses general functions related to the Message Organizer.    From this window you may 
determine the length of time between checks for new mail, choose how folders are cleaned on 
exit, and enable priority headers.    The window below, is an example of one users options:

Figure 12 Message Organizer Options Window

This user has chosen to poll for mail every 10 minutes, clean folders on exit if prompted and 
highlight the next message after the current message in the Message Organizer has been 
deleted. 

Priority headers have also been enabled.      Priority headers indicate the urgency of a message 
that has been mailed to you by coloring the message text (e.g.    sender, subject, date, and size) 
in your folder. Selecting the color of low, medium and high priority messages is done through 
Tools/Options/Edit/Fonts. For more information on setting colors please see Font Options.



Compose Options
Choosing the Compose icon in Edit under the Tools/Options Menu will allow you to set the 
defaults you wish to use for any outgoing email.    Changing any of these elements modifies the 
default settings for all future messages.    For example, you may wish to send all mail to a specific
folder in order to track your daily activity;    this folder would be specified under Sentmail Folder.    
The Compose Options window will appear similar to the following figure:

Figure 13 Compose Options Window

Below is a brief description of the function for each element in the window:

Options: This area contains the default setting for Read and Delivery Receipts used to determine
whether messages have been delivered to the recipient or read or opened by the recipient; Save 
Message which is used to save your outgoing message to a predetermined location (by default 
set to the sentmail folder in the Local Folders message service); and Queue Message, used 
when you are either disconnected from the network or wish send the message at a later time. 
Queued messages are generally saved to the outbox folder in the Local Folders message 
service. Select or deselect any number of these items by clicking on the selection box.    
Remember that each of these options can be toggled under the Compose/Options menu or 
through the Option button on the toolbar for an individual message.

Line Wrapping: Offers the user with the option to set the maximum line length for the Compose 
window. If line wrap is set to 70 characters, each line typed in the text portion of the Compose 
window will automatically wrap at 70 characters. If, however, the Compose window is narrower 
than the line wrap value, lines will be wrapped at the right-most edge of the compose window.    
The default setting is 72 characters which is the standard for most typed pages.

Message Priority:    Enables you to set the urgency of all messages sent. Since you will likely 
adjust the default priority level based on the task-at-hand, select the one you use most often, 
usually normal priority.    The priority can be modified for each compose session under 
Compose/Options menu or by clicking the Option button on the toolbar.



Sentmail and Draft Folders:    The location of both the sentmail and draft folders can be 
specified from this window. The location of these folders depends on your needs as a Simeon 
Mail user. If you are using the Simeon Mail Session Manager for online and offline operation then 
you should probably leave the location of sentmail and drafts in your Local Folders message 
service. This way, regardless of where you are, you will have access to your draft and sent 
messages from your laptop. If you are not using online/offline, the location of these folders is 
entirely up to you. Selecting the Browse button will enable you to change the location of these 
folders from the existing list or create a new folder. The default location for both sentmail and 
drafts is the Local Folders message service.

Compose Window after Sending:    The disposition of a Compose window can be set to either 
close, clear, or remain open after a message has been sent.    Simply select the preferred option 
by clicking on the radio button beside your preference. Again, this default can be overridden for 
each compose session either through the Compose/Options menu or the Option button on the 
toolbar.



Editor Options
Under the Tools/Options/Edit menu is the Editor option for setting the external editor you wish 
to use during a compose session. This editor can be any word processing or text editor you have 
access to from your computer. You can choose the editor using the Browse button. You also 
have the option to use the editor for all compose sessions by clicking Always use External 
Editor in this window.

An additional function of the Simeon editor is the ability to launch a web browser directly from a 
viewer window when you double click on a World Wide Web citation. Input the complete 
pathname to your browser of choice or click on Browse to navigate to the location. Selecting one 
of Never, Always or Prompt dictates what action will be taken then you double click on the URL. 
Never is used when either no browser is available or you do not wish to launch from Simeon. 
Always will automatically launch the chosen browser and Prompt will ask if you really want to 
launch the browser to view the web site.

Figure 14 Editor Options Window



Reply Options
Reply Options can be accessed under the Tools/Options/Edit menu by selecting the Reply 
icon.    In these options you can determine the defaults associated with a reply window.    To 
customize these Options, select one of the radio buttons for each of the Options.    Simeon is 
shipped with the defaults set to Prompt.    An example of the Reply Options Window is below:

Figure 15 Reply Options Window

For each of the elements you may select only one of the three options: Never, Always, or Prompt. 
Selecting Never and Always is like saying no and yes respectively; selecting Prompt is like saying
maybe and Simeon will respond by asking you to decide when a reply is requested.    A brief 
description of each element is discussed below.

Reply to All Recipients allows you to choose if you wish to reply to everyone who originally 
received the message or just the originator.

Include Original Message Text allows you to decide if the original message text will be inserted 
into the reply message text.    The included text is easily distinguished from new text by using a 
specific character prior to each line. Accessing the list adjacent to Original Text Prefix will give 
you the option of choosing a ">", "!", "#" or "$" as the prefix character to original text. 

As well, you have the option of wrapping the original text to match your Reply window size rather 
than the originating line length.    You can now incorporate your response in the original message 
text which can be useful if you are responding to questions.    To type in the original message text,
place the cursor in the location where you wish to insert additional text and then type or paste in 
the new text.

Reply Subject Prefix: To identify to the recipient that the e-mail being received is in reply to their 
original message Simeon inserts a prefix on the subject line indicating same. The available 
options are "Re", "re", "RE", "Reply" and "REPLY".

Hint    You may insert your own Reply Subject Prefix in the first box in this section is you wish to 
use a prefix other than one already available.





Forward Options
The Forward icon under the Tools/Options/Edit menu allows you to set the options when 
forwarding mail. 

Figure 16 Forward Options Window

Forward the Message as an Attachment: You have the option of including the forwarded 
message text either in the message portion of your forward window or as an attachment. If you 
forward messages as attachments they will sent with a .tmp file extension. These attachments are
sent as Application/RFC822 and can be viewed using any plain text or word processing package 
(i.e. Notepad or Word for Windows). You will probably want to set up a viewer for messages 
received as attachments with your personal preference of viewer. Please refer to Adding New 
Helper Applications for more information on setting this up.

Wrap Original Text: If you have chosen to include the original message text in your message 
rather than as an attachment, you have the option of wrapping the original message text so it 
matches your forward window size rather than the line length in the original message.

Forward Subject Prefix: To properly identify forwarded mail, Simeon Mail inserts a notification to 
the recipient on the subject line in addition to the original subject text. The options for this 
notification are "fwd", "Fwd", "FWD", "Forward" and "FORWARD". You may also state whether 
this notification will appear as a prefix or suffix to the subject line.

Hint    You may insert your own Forward Subject Prefix in the first box in this section is you wish 
to use a prefix other than one already available.



Send Options
Clicking on the Send icon after selecting Edit under the Tools/Options menu brings up a 
window outlining the options for sending mail.    In this window you can modify three elements 
related to sending mail:    the Main Delivery Host, alias expansion Foreground or Background 
send, and the destination of mail queued for Background.    A description of each default is listed 
below:

Main Delivery Host is the server responsible for sending your mail.    Simeon initially determines 
the Hostname and Port number on initial set-up.    However, if you switch your Main Delivery Host 
you can modify both the hostname and port number used by the server in the Send Options 
window. You will note that the Port field has been left blank; this is because Simeon is shipped 
with standard port numbers set.

Alias Expansion:    Selecting to Auto Expand Aliases on Send will the search all Address Books 
that have Search in Compose selected in the Address Book Properties window to expand aliases 
when a message is sent.    You have the choice to either search against the Name, Alias, or Email
field of each address record for possible matches.

Message Sending:    Selecting either Foreground or Background send will determine when your 
mail is sent. If you choose Foreground Send all composed mail will be sent immediately. 
Selecting Background will send all outgoing email to the queued messages folder, usually outbox,
to be sent through the submission manager.

Queued Messages Folder: by clicking on the Browse button you will be able to direct all queued 
mail to the message service and folder of your choice. The default location for storing queued 
message is the outbox folder in the Local Folders message service. You can also create a new 
folder by selecting the message service and clicking on the New Folder button. Because of the 
nature of the outbox folder, any new folder created for storing queued messages should be in a 
local message service. To queue messages when Foreground Send has been selected, toggle 
the Queue Message option under the Compose/Options menu. Remote users will find this 
feature useful when they are not connected to a network. For more information on offline 
operations please see Introduction. 

The Send Options Window resembles the following:



Figure 17 Send Options Window



Viewer Options
Viewer Options can be accessed by clicking on the Viewer icon in the Options window under the 
Tools/Options/Edit menu.    The number of message viewers can be modified from within this 
window by selecting either:    One viewer, One viewer per folder, or One viewer per message.  
Below is a description of each of these options:

One viewer is selected if you wish to continually reuse a viewer window.    For example, when 
you access different folders, message groups and messages, the same viewer window will be 
used for each message viewed.

One viewer per folder can be selected if you prefer to have separate viewers for each folder that
is opened.    For example, opening two folders and viewing a message in each will produce two 
separate viewers.

One viewer per message:    will open a new viewer window for each message that is opened.    
This may be of some concern when viewing numerous messages. 

Auto Wrap Message: This section dictates whether the mail message being viewed will be 
automatically wrapped to coincide with your viewer window size. A setting of Never will never 
wrap the incoming message in the viewer. Setting the option to Always will always wrap the 
incoming message. Remember, if you set to Always any incoming message that was sent with 
specific formatting such as tables will be received skewed.

View Action on Message Deletion: This area lets you decide the next action of the viewer 
window when the currently displayed message has been deleted. Next will display the next 
message in the list in the same viewer; Previous will display the previous message in the list in 
the same viewer; Close will close the current viewer.

An opened viewer window will resemble the figure below:

Figure 18 Viewer Options Window



Addressbook Organizer Options
Selecting Edit from the Tools/Options menu and then clicking on the Addressbook Organizer 
icon, will give you access to information as to which computer on the network stores your address
books. These settings are initially set when you setup Simeon Mail on your computer.    You may 
be required to modify these values if you are working remotely or in a different office.    Both can 
be modified by clicking on the appropriate box, deleting the old information and then typing in the 
new information.    The Hostname and Port number will likely be supplied by your Systems 
Administrator, however, Simeon Mail has been shipped with the standard port numbers for these 
hosts types.    

More:
Changing Address Book Host



Changing Address Book Host
The hostname and port Simeon Mail reads from can be changed to reflect a change in your 
working environment.    The X.500 Host and Address Book Host represent two types of Address 
Books    that may be accessed with your network.      An X.500 host will enable you to utilize 
Simeon Mail's Public Directory giving you access to e-mail addresses and numerous other pieces
of information on various individuals. For more information on the Public Directory please see 
Introduction.

The Addressbook Organizer Options window will resemble the following:

Figure 19 Addressbook Organizer Options Window



Logging Options
Logging Options, accessed by clicking on the Logging button after selecting Edit from the 
Tools/Options menu, contains information that may periodically be used by a System 
Administrator to find the cause of any problems occurring with Simeon Mail resident on your 
computer.    Your System Administrator may ask you to modify both the detail and subsystem(s) 
monitored during a logging session. A brief description of each can be found below:

· Log Detail:    The level may be changed by clicking on the radio button beside the desired 
level.    

· Subsystems to Log:    To choose the subsystem(s) that is to be Logged, click on the name of
each subsystem that is to be included.    The Check All button will automatically select all 
subsystems and Uncheck All button will deselect check boxes.    It is good practice to deselect
all items prior to selecting subsystems to be Logged.    

A window similar to the one below will be displayed when Logging Options have been selected:

Figure 20 Logging Options Window



Saving Options
The Save As feature in Simeon Mail is an extremely powerful tool that will allow you to get the 
exact Simeon mail configuration you require at any time regardless of your status (online or 
offline) or your needs (local, remote or different mail hosts). Not only can you save each of these 
configurations in a "friendly" name but you can start each Simeon Mail session with any one of 
your saved configurations.

If you have not saved your Options, wish to change where your Options are stored, or wish to 
save the current configuration under a different name, select Save as from the Tools/Options 
menu and complete the following window:

Figure 21 Save as... Options Window

The New button will let you name and set the parameters for a new configuration. The Modify 
button will allow you to modify an already saved configuration.

Name: Name your new configuration using any name you wish. You may use spaces, numbers 
and special characters such as # $ % ! or ?.

Option Storage Location: Choose whether this configuration will be saved to your local hard 
drive or on the remote IMSP server. Offline configurations and those configurations used when 
logging in over a modem from the same laptop should be saved locally. Configurations used in 
the office would be saved on the remote server.

Configuration Properties: The configuration properties lets you choose whether this 
configuration will be your online default or your offline default. 

Path & Filename: If you have chosen Local Disk as your storage location this area will be 
available to select the location where the file holding your configuration will be stored.    If you are 
unsure of where you want to store the file use the Browse… button to navigate your C:\ drive.

IMSP Host and Port: If you have chosen Remote server as your storage location this is where 
the name and port number of the IMSP server that will store your configuration will go. Generally 
the IMSP host is the proper name of your IMSP server and the port number is 406. If you are 
unsure please check with your System Administrator.



Loading Options
You may elect to have two "option-sets" depending on your needs; one may be residing locally on
your hard drive while the other resides on a specified IMSP host computer. To move from one 
option set to another requires you to Load from the Tools/Options menu.    The window used to 
load your options will be similar to the one below:

Figure 22 Load... Options Window

You may switch between a local or remote configuration storage location. If you have more than 
one local configuration use the Browse… button to access the different configuration files on your
system.



Save Desktop on Exit
The menu item Save Desktop on Exit under Tools/Options determines whether the current 
configuration of your Message Organizer will be saved from session to session. 

Note    This option does not save the state of the Addressbook Organizer or whether objects such 
as a viewer or compose window are open on exit. 



Introduction
Reading and manipulating received messages are the most fundamental tasks associated with 
Simeon Mail. This chapter covers the basics of these functions as well as how to deal with 
attachments.



Viewing a Message
Viewing the contents of a Message Group will provide you with a message summary containing: 
message status, author, subject, date received, size, and the urgency of the message (i.e. 
indicated by color of text) if you have selected to Enable Priority Headers in the 
Tools/Options/Edit menu under the Message Organizer.

Figure 23 List of Messages in Message Group

To view a message double click the mouse anywhere on the mail message you wish to view. A 
message viewer window similar to the following will appear:

Figure 24 Message Viewer

Message viewer windows generally consist of two parts. The upper envelope portion of the 
window contains the name and email address of the sender and recipient and perhaps a subject 
line and who may have received copies of the message. This is referred to as the envelope 
section.    The lower portion of the message viewer contains the text of the message. If an 
attachment has been added to the message an icon will appear at the bottom of the message 
indicating the type of attachment and its name.

Hint:    If you are getting long lines in your viewer window go to Edit/Wrap Text. Your lines will 
now wrap to the size of the viewer window.





Capturing Addresses
Simeon Mail has the capability of capturing email addresses from received messages into any 
existing address book. With the message displayed in a viewer window select Capture Address 
from the Address menu. Simeon Mail will locate all your local and remove address books and 
bring up a selection window allowing you to choose which book is to receive the new address.

Figure 25 Addressbook Selection for Capturing Addresses



Message Headers
There are two types of message headers: raw and short. The short message header contains 
only the information as entered in the To, Subject and CC fields as well as the date sent and 
sender's name.    The raw header contains information such as the routing information of the 
email, priority and any other pertinent information regarding the sending or receiving of the email. 
To view the different message headers select Raw Header or Short Header from the View 
menu.



Navigating in Viewer
Once the viewer window has been displayed you may navigate through your messages by using 
the Next and Prev buttons on the toolbar.

Click the Next button to view the next message in the
list. Each time the Next button is selected the viewer 
will display the next message in your list until all 
messages in the Message Group have been 
displayed.
Click on the Prev button to display the messages that
appear in your message list previous to the one 
currently displayed in the viewer. Again, the viewer 
will display the previous message in the list until the 
first message in the message group has been 
displayed.

Viewing Attachments
If a message contains attachments such as a 
spreadsheet or a word processing document, an 
additional box will appear at the bottom of the 
viewer window. This box, called the Attachments 
Box, contains the icon associated with the type of 
attachment sent through Simeon Mail.

Messages that contain attachments are called multipart messages.    To view the attachments in 
multipart messages double click on the attachment. The originating (or comparable) application 
must be resident on your computer in order for Simeon to open the attachment.    Simeon Mail will
start the appropriate application and then open the attachment file.    Simeon Mail may not 
recognize an attachment since new types of programs are continually being developed.    In this 
case it then requests that you define the program to view the attachment with using the following 
window:

Figure 26 Choosing a Helper Application



If this occurs please refer to Helper Applications Options or request the assistance of your 
Systems Administrator.



Viewing URLs
Simeon Mail has the ability to automatically launch a web browser from a unified resource link 
(URL) in a mail message.    This is done by double clicking on the World    Wide Web citation. If 
you have not specified the browser under Tools/Options/Edit/Editor Simeon will ask the path to 
the browser you wish to use.

Figure 27 Web Browser Path

If you are unsure of the path use the Browse button to navigate to your browser of choice.

For more information on choosing and launching a web browser please refer to Editor Options.



Deleting Current Message
From the Viewer Window
Using the Message List



From the Viewer Window
Clicking on the Del button, found on the toolbar, will 
delete the message currently displayed in the 
viewer.

Remember    Remember that the next message displayed depends on what setting was used 
under Tools/Options/Edit/Viewer. You may either display the next message, previous message 
or close the viewer window.



Using the Message List
To delete a non-displayed message select the 
appropriate message in the expanded folder or 
folder window and click the Del button.

Messages may also be deleted by using the Delete option under the File menu. Remember, if 
you have chosen to view messages without message groups, all the deleted messages will 
remain in the list and will be marked with an "X".    Deleted messages may be undeleted by 
selecting the message and either clicking on the Undel button or by using the Undelete option 
under the Message menu.    To remove all of the deleted messages from the list, click on the 
Clean button or select Clean from the Folder menu.    Remember that once you have selected 
the Clean button, the cleaned messages cannot be recovered.

Remember    The message that will be highlighted after a delete will be that set under 
Tools/Options/Edit/Message Organizer. The options are to highlight either the next message or
the previous message from the one just deleted.



Deleting Multiple Messages
To delete more than one message at a time, select the first message to be deleted by clicking on 
that message. Each subsequent message you wish to delete is selected by holding the CTRL key 
and clicking on the message. You can delete a block of messages by clicking on the first 
message to be deleted with the SHIFT key depressed, then selecting the final message. After all 
messages have been selected click the Del button or select Delete from the Message menu.



Deleting all Messages in a Group
To delete all messages contained in a specific message group, first select that message group 
then click on Del in the toolbar. Simeon Mail will ask you to choose between deleting the message
group, all messages contained in that group or cancel the operation.    Selecting Messages will 
delete only the messages and leave the message group intact. Selecting Group will delete the 
message group only and redistribute the messages to other message groups in that folder.    All 
deleted messages are placed into that folder's Deleted message group and will be marked with 
an "X".    Remember, if you delete all the messages in a group set to hide when empty, the 
Group will no longer appear in the window after deleting all the messages in that group.



Undeleting a Message
You may undelete or restore messages that have previously been deleted during the current 
Simeon Mail session or at any time before a folder is cleaned. This is accomplished by taking the 
following steps:

1. Expand the Deleted message group, if you have 
chosen to view message groups, under the 
appropriate folder (e.g. inbox).

2. Select the appropriate message to undelete by 
clicking on it.

3. Click on the Undel button in the toolbar. The 
message will be placed back in its original message 
group and will no longer be marked with an "X".

If you wish to undelete all messages in the Deleted message group, select the group and click on 
the Undel button in the toolbar.    Simeon Mail will prompt you to either confirm the undelete or 
cancel the operation.    All messages will return to their respective message groups within that 
folder.



Cleaning Deleted Messages
Each time you exit from Simeon Mail you will have
the option of cleaning any deleted messages. You 
may wish, however, to periodically clean up 
messages that have been deleted within a folder. 
This is done by selecting the folder and clicking 
the mouse on the Clean button.

Copying Multiple Messages using Drag and Drop
To copy a number of messages from one folder to another, take the following steps:

1. Click to select the first message.

2. For each subsequent message to be copied keep the CTRL key depressed and click on the 
desired message. Continue until all desired messages are selected. If you have a block of 
messages you wish to copy, depress the SHIFT key and click on the first then final message of
the block.

3. Keeping the mouse button and CTRL key depressed drag the highlighted messages over the 
desired folder then release the mouse button and the CTRL key.



Moving Multiple Messages using Drag and Drop
To move a series of messages from one folder to another, take the following steps:

1. Click to select the first message.

2. Press the SHIFT key and click the mouse to select the last message in the series or use CTRL 
to select the desired messages.    

3. Keeping the mouse button and SHIFT key depressed on the block drag the highlighted 
messages over to the new folder, then release mouse button and the SHIFT key.    

Releasing the mouse button and SHIFT key the will result in the messages being moved into the 
new folder and the messages in the original folder being moved into that folder's Deleted 
message group.



Copying and Moving Between Folders
In some instances, it may not be feasible to drag and drop messages from one folder to another. 
This may be due to the size of your folders, where the folders are located (different message 
services) or the area available on your screen. In this case you may elect to use the Copy to 
Folder or Move to Folder options available under the Message menu. To use this feature take 
the following steps:

1. Select the message or messages you wish to move or copy. Select a block of messages 
using the SHIFT key and individual messages using the CTRL key.

2. From the Message menu select either Copy to Folder or Move to Folder depending on the 
action required. The following window will appear allowing you to navigate to the required 
Message service and then choose the folder where you wish the messages to be placed. 
Click on OK to perform the operation or Cancel to cancel the move or copy.

Figure 28 Copy/Move to Folder Window

You may also move a mail message and get a move 
window similar to the one above by selecting a 
message or messages and clicking on the Move 
button, shown at left, on the toolbar.

Saving Messages
There are a number of ways to save messages to a file. You may choose to save the text only, 
the attachment only or the entire multipart message.

More:
Saving Message Portion



Saving Message Portion
Messages, whether plain text or multipart, may be 
saved either to a file on the hard drive, network drive 
or diskette. To save either the text of a message or an
attachment, first open the message into a Viewer and
select the message or attachment. Click the Save 
button.

Once the Save button has been selected, the following window will appear on the screen, allowing
you to specify the filename and the location.

Figure 29 Save Message Window

When choosing a file name remember that you will be restricted by the DOS name limitation of 8 
characters if you are working in Window 3.1. 

Hint:    You may also select either an attachment or the message text and use the Message 
menu items of Save Text to File or Save Attachment to File.

If you highlight the message in your folder and click on Save, Simeon Mail will save all portions of
the selected message, including all attachments. Attachments designated as an Application will 
be saved encoded. Encoded text really has no meaning to a user as it is a document that has 
been saved to a file with all the formatting codes included. If a message is multipart it is better to 
select the portion of the message you want to save, either text or attachment, and click on Save. 
Simeon Mail will then save in the appropriate format.



Printing a Message
To print the message currently displayed in the 
Viewer window, click the mouse on the Print 
button or select Print from the File menu. 

To print from the Message services window, when the Viewer is not displayed, select the 
message to be printed and click on Print or select Print from the File menu.    In each case, the 
message icon will be changed to reflect that the message has been viewed.    If a read receipt has
been requested by the sender, it will also be sent at this time.

More:
Printing Options
Defining Headers and Footers



Printing Options
On selecting Page Setup from the File menu, you will be able to define a default header, footer 
and margins for all printed messages.    Headers contain information defined by you and are at 
the top of each printed page. Footers again contain information defined by you and are at the 
bottom of each printed page.

Figure 30 Page Layout Options

To change any of the current values, place the cursor in the appropriate box, delete the current 
value and type in the desired information.

The top and bottom margin values are indicated by a number of lines, while the left and right 
margin values are indicated by a number of characters.



Defining Headers and Footers
Headers and footers may be printed using variables or text. A variable is information that can be 
extracted from the mail message itself, while text is information that you type directly into either 
the header or footer box. Any information contained in a header or footer can be positioned on the
line, either left, center or right justified.

The following are the variables available for printing:

$from Prints the name and e-mail address of the individual sending the message as it 
appears in the envelope section

$date Prints the date the message was sent

$subj Prints the subject of the message as it appears in the envelope section

$pdate Prints the current date (printing date)

$page Prints page numbers

Any variable or text can be positioned on the line using the following:

l The "l" key for left justified text

c The "c" for center text

r The "r" for right justified text

In all cases the l, c or r must be preceded by a space and followed by a space. Positional 
characters need not be preceded by a space if they are the first letter of the header or footer.

Text placed in a header or footer must be enclosed in single quotes. If a single quote is required 
in the text, use two single quotes. For example:

'Laura''s Mail'

More:
Examples



Examples
A print layout window with the following information in the header and footer will produce output 
as follows:

Figure 31 Example of Header and Footer

The header will read:

John Doe                                                          More Action Items                          November 23, 1996

The footer will read:

Current Action List                                                                                                                                                          
Page 1



Printing Attachments
Attachments must be printed using the application specific to that particular attachment. For 
instance, if a Word for Windows document has been attached to a Simeon Mail message, then 
double-click on the icon depicting the Word for Windows document in the Attachments Box. This 
will start Word for Windows on your computer and load the attachment so you may print from that 
application.    You may have to define the application that will be used to view the attachment if 
Simeon is unable to recognize the application that created the attachment. For information on 
adding a new helper application please see Adding New Helper Applications.



Printer Setup and Options
Simeon Mail has the facility for selecting printers, page orientation and other printing options. The 
printing options are accessed through the File menu by selecting Printer Setup.

Figure 32 Print Setup Window

You may select the printer to use and the paper tray, page orientation and size. Selecting the 
Properties button on the Print Setup window will allow you more advanced printer options. 
Please refer to your Windows User Guide for information on printers.



Changing the Status of a Message
You may change the status of any message using the Message menu. For instance, if you 
opened a message but had to close it before reading all of the message, you may elect to change
the status to Not Viewed.    Marking a message Special might serve as a reminder to you that it 
should be dealt with within a certain time period.

There are three status changes that you may make to a message:

1. Mark Not Viewed—if a message has been opened but not read this will change the status 
icon back to the original closed icon.

2. Mark Replied—Choosing this status change will put an "R" beside the message, indicating 
that you have sent a reply.    Messages replied to using the Reply feature of Simeon Mail will 
automatically have the "R" beside the message.    In each case, the status icon will change to 
indicate that it has been read.

3. Mark Special—To bring attention to a specific message you may mark it as Special. This will 
put an asterisk ("*") beside the message.

In all cases you may toggle the status of a message. For instance, if a message has been 
marked as Special, going to the Message menu you will note that the option is now Mark Not 
Special and you may toggle it accordingly.    When viewing messages within a folder or Viewer, 
you may toggle the message as Special or Replied.    Toggling a message Not Viewed when 
viewing will obviously result in a viewed message.    In order to change messages from Viewed to
Not Viewed you must be in the folder.    Message status can also be modified from within the 
Message Properties window.



Introduction
This chapter describes how to compose a mail message, add an attachment to a mail message 
and use Simeon Mail's built-in address book feature to access email addresses of people to 
whom you often send mail.



Compose Window
The Compose window is divided into three components: the envelope section, resize bar, and the
message text section.    These components will allow you to modify the message to suit your 
particular needs.    The following section describes the process of designing and sending a 
message.

To access the Compose window, click the mouse
on the Comp button in the toolbar or select New 
Message from the File/New menu. The 
following window will appear:

Figure 33 Compose Window

The envelope section contains all the information regarding who will be receiving the email and 
the nature of the message. The message section contains the typed message itself and any 
attachments that may be added.    The resize bar allows you to resize either the envelope or 
message section depending on your needs. For instance, if you are not in the habit of sending 
blind carbon copies, then you may wish to resize the envelope section so that Bcc does not show 
in the window.

To resize, simply place the mouse on the resize bar until the cursor appears as crosshairs (+), 
then hold the left mouse button and drag the resize bar up or down to the desired location.



Composing a Message
After accessing a compose window you are ready to insert the To, Subject, Cc and Bcc fields in 
the envelope section and begin typing the text of the message in the message section.

To begin addressing the email, move the mouse to the To field and click to place the cursor in that
field. Begin typing the email address of the receiving party. More than one address may be 
inserted in this field, each one separated by a comma. Email addresses may be obtained by 
reviewing received messages, from your personal Address Book available through Simeon Mail, 
or by asking the recipient for their email address. If installed at your site, email addresses can 
also be obtained through Simeon Mail's Public Directory

Hitting the tab key will move you to the next box in the envelope section. The Subject section will 
provide the recipient of the email with an idea of what the message is about. The Cc field will 
contain the email addresses of others receiving the message and will be visible in the message 
header of each recipient. The Bcc (blind carbon copy) field will contain the email addresses of 
others receiving the message, however, the contents of this field will not be visible to any other 
recipients of the message. As with the To field, the Cc and Bcc fields may contain more than one 
address, each separated by a comma.

After all envelope section fields have been completed, tab or click in the message section and 
type the appropriate message.



Sending a Message
When the message has been completed, click 
on Send to send the message to the desired 
parties or select Send from the Compose 
menu.

Using the Address Book
An address book contains email addresses for those parties to whom you most often send mail. 
These addresses may be internal (within your organization) or external (outside your 
organization).

To access the Addressbook Organizer to insert 
an email address, click the mouse on the Addr 
button or select Open Address Books from 
the Address menu.    An Addressbook 
Organizer, similar to the following, will appear.

Figure 34 Addressbook Organizer

This window is manipulated in the same 
manner as the Message Organizer window. To 
expand or collapse the list of addresses, click 
the mouse on the plus sign beside the Address 
Book or double click on the icon of the Address 
Book.

Once the Address Book has been opened, the names contained in that book will appear (both 
individuals and lists). To insert a name or list in the To field of your Compose window:

1. Click on the name you wish to insert. If you have selected a list name, all members of that 
group will be selected.

2. Click on the To: button on the Toolbar.

The selected address or address list is now 
pasted into the To: field of the Compose window. 
Inserting it into the Cc: and Bcc: fields is done by 
clicking on either the Cc: or Bcc: buttons or 
selecting Paste Address to Compose (To), 
(Cc), or (Bcc) under the Address menu.

More:
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Address Properties
Selecting the Info button while a name has been 
selected in the Addressbook Organizer will bring 
up a window that will set out the attributes of 
that specific address. This allows you to ensure 
that the selected address is the one required.

Using Alias Expansion
Each entry located in any Address Book has the option of containing a shortened form of the 
email address. This short form, or alias, is extremely useful since it does not require you to 
physically access an Address Book in order to insert a correct email address.

In any of the To:, Cc: or Bcc: fields in a Compose, Reply or Forward window you may input the 
alias name of the recipient intended to receive the message. This alias is intended to be a word or
name that you find easier to remember. For instance, Joe Doe's email address at ABC Company 
is jdoe@abc.co. You may not always remember what his identification on his system is. In this 
case, his alias would be something you find easy to remember, perhaps "joe". 

Typing joe in the To: field and clicking on the Expnd 
button or selecting Compose menu/Expand 
Aliases will expand joe to "Joe Doe 
<jdoe@abc.co>".

You may enter as many aliases in any of the recipient fields as you wish. Clicking on Expnd will 
expand all of them. If an address match is found for more than one person Simeon Mail will 
request that you select the desired individual from a list of the full names.    

Figure 35 Alias Expansion Selection Window

In order for an alias to properly expand, you must ensure that the Address Book has the option 
"Search in Compose" selected. This can be accomplished either when creating an Address Book 
or in the Address Book Properties window accessed by selecting the address book and clicking 
on the Info button or selecting Properties from the File menu.

Hint    Aliases can automatically be expanded upon sending by choosing the Auto Expand 
Aliases on send option under the Tools/Options/Edit menu and then clicking on the Send icon.

For further information on how to designate an alias for an email address and ensure that your 
Address Book will properly expand alias names please refer to Aliases Aliases.



Editing a Message in a Compose Window
The editor supplied with Simeon Mail has the standard editing tools as well as the enhanced 
features of: Cut/Copy and Paste, Clear, Select All, Find and Replace, Spell Check and Wrap 
Text.    With the exception of Spell Check which is found under the Tools menu, these editing 
tools can be selected from the Edit menu.    A brief description of these features is below:

More:
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Copy or Cut and Paste
It is possible to copy and paste text from another Viewer window or other applications such as 
Notepad or Microsoft Word into the Compose window. This is accomplished in the same manner 
as any other copy and paste function by:

1. Highlighting the appropriate text to be copied by clicking on it or use Select All to highlight all 
text;

2. Selecting Copy or Cut from the Edit menu in the originating application;

3. Selecting Paste from the Edit menu in Simeon Mail.



Clear
You may clear or delete certain portions of text of any compose, reply or forward session by first 
highlighting the appropriate text and selecting Clear from the Edit menu. This will remove the 
selected text from the window and will not place it on the clipboard for later use.



Find and Replace
Simeon Mail also has the ability to either locate or substitute desired word string for another    
word string.    In order to find and replace words in a Compose Window, follow these steps:

1. Select the desired action: Find or Replace from the Edit menu.

2. If using Find type in the word you wish to find. If using Replace type both the word to find 
and its replacement.

3. Click on OK for each of the occurrences of the word you are replacing.



Spell Check
To bring up Simeon Mail's spell checker, click 
on the Spell button on the toolbar or select 
Spell Check from the Tools menu.

Simeon Mail can search your document for spelling errors using Simeon Mail's resident 
dictionary. Similar to spell checking in Microsoft Word, this feature supplies you with the correctly 
spelled words or a choice of possible words to replace incorrectly spelled words.    You may also 
add words to your own dictionary by selecting the Add button with a word in the Change to field.

Hint:    The words used in your personal dictionary for Simeon Mail reside in a file called dict.txt 
found in the Simeon Mail working directory. If you already have a dictionary file you can import 
those words in dict.txt. Just remember, one word on each line.



Wrapping Text
All viewer and compose windows have the ability to wrap text that is too long for the current 
window. This is accomplished through the Edit menu by selecting Wrap Text. Here are some 
guidelines on how text will be wrapped:

1. If no text has been selected all text in the message section will be wrapped.

2. If you have highlighted a paragraph of text only that portion will be wrapped.



Inserting a File
You may insert a file generated through Notepad or other plain text editor into the message text 
portion of a Compose Window.    The size of the file that can be inserted is not limited, however, if 
the size of the file is greater than 100 Kb, Simeon will give you the choice to insert the file as an 
attachment or continue with the insertion.    Accomplish this by taking the following steps:

1. Place the cursor in the location of the message text portion of the Compose window where 
the inserted text is to be placed.

2. Select Insert File from the Edit menu..

3. From the dialogue box, a sample of which is shown below, navigate to the location of the file 
to be inserted and click on OK to place the file into your Compose window.

Figure 36 Insert File Window

There are pros and cons to inserting or attaching files to an email message. For instance, you 
may want to consider the recipient's ability to receive attachments; do they have the programs to 
read the attachments. On the other hand, if your inserted file has tabs and formatting within the 
document, it may be better to send as an attachment so the recipient can view the attachment as 
written. Remember, not all computers are created equal and tab stops may differ from computer 
to computer.

Note    Any text inserted into a compose window will be subject to the wrapping parameters set 
under Tools/Options/Edit/Compose. The same holds true for reply and forward windows found 
consecutively under Reply and Forward in the Tools/Options/Edit menu. If no wrapping is set 
in these options you may wrap on an "as needed" basis through Edit/Wrap Text.



General Attachments
Other files, such as word processing documents or 
spreadsheets, images or sounds, may be attached 
to a message and sent to all recipients. To attach 
one of these files to a message, click on the Attach 
button or select Attach file/Standard under the 
Compose menu. The following window will appear
allowing you to select the file to attach:

Figure 37 Attach File Window

Once you have selected the appropriate file, Simeon Mail will automatically attach it to your 
Compose window if a Helper Application already exists for that type of attachment. 

Note:    When attaching a file to an email message, Simeon mail attaches the original of that 
document. This means if you modify the original of the attachment the new modified file is the one
that will be incorporated when you eventually send your message.

More:
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Attaching Unknown Helper Applications
If a Helper Application does not exist, Simeon Mail will bring up the following window allowing you
to choose how the file will be attached. 

Figure 38 Choose Attachment Type Window

You may need to use the Browse button to access the appropriate application for the attachment.
Most important, though, is the Attachment Types section. This sets out the appropriate type and 
subtype for the attachment according to predefined communication standards. The recipient of 
your message needs to know this information to properly view the attachment. Communication 
Protocol will give you a list of commonly used types and subtypes.

After you have selected a Helper Application, Simeon Mail will ask if you wish to save this 
application and suggest a name. You may use the suggested name or change it to any name that
will adequately describe this Helper Application to you.

Figure 39 Naming a New Helper Application

An icon representing the application and file name will appear at the bottom of the Compose 
window. 



Special Attachments
Simeon gives you the ability to attach such specialized files as uuencoded files or binhex'd files 
"on the fly". That is to say, if you want to send a uuencoded file, select any file to attach and 
Simeon will automatically uuencode the information. Simeon will also automatically uudecode the 
attachment on the other end when that attachment is saved to a file.

Bin-hex files are dealt with in the same way. A Simeon Macintosh user can send you a bin-hex'd 
file. Upon receipt if you select Save Attachment to File from the Message menu, Simeon will 
unbin-hex the file saving it in its original state whether that is a Word for Windows document, plain
text, image or any other application.

To attach a uuencoded or bin-hex'd file take these steps:

1. Open a Compose window using either the Comp button on the toolbar or select Message 
from the File/New menu.

2. From the Compose menu select Attach File/Other/UUEncode or BinHex depending on 
who is to receive the file.

3. Navigate to the appropriate place on your network were the file resides, select the file click 
Open. The file will automatically uuencode or binhex and attach to your email message. 

4. Complete the email message envelope and message text area and Send.



Extracting a Uuencoded or Binhex'd Attachment
Attachments that are uuencoded are automatically sent as Application/X-Uuencode. Attachments 
that are BinHex'd are sent as Application/mac-binhex40. These files cannot be launched so they 
must be saved to a file. Simeon Mail will automatically uudecode or unbinhex as necessary when 
they are saved.

To save a uuencoded or binhex'd file take the following steps:

1. Select the attachment you wish to save and either click on Send on the toolbar or select 
Save/Attachment from the Message menu.

2. Navigate to the area on your network where you wish the file saved.

3. Click Save.



Detaching Files
You may delete the attachment by selecting the 
attachment, then clicking on the Detach button 
found on the toolbar or by selecting Detach File 
from the Compose menu.

Using the Phone Message Form
A predesigned form for filling out email messages associated with telephone calls is available. To 
use this form select Phone Message from the File/New menu. The following form will appear on 
your computer for you to fill in accordingly.    Each field may be accessed either by tabbing down 
the fields or selecting each with your mouse.

Figure 40 Phone Message Form

Once you have filled in the form, click on the Send button or choose Send from the Compose 
menu.



Saving a Message to Drafts
Occasionally you may choose to quit a Compose window before you have finished entering the 
entire message. You may close a Compose session by either double clicking on the Control menu
button in the Compose window, or selecting Close from the File menu.

If you do quit, Simeon Mail will prompt you for the disposition of the draft message and ask you to
select either: save the draft message to the "drafts folder"; do not save the message; or cancel 
which deletes the message and closes the window.    The default location for the drafts folder is 
the Local Folders Message service. To specify a different location please see Compose Options. 

Note:    Selecting Save to Drafts from the Compose menu will automatically save the message 
to your specified drafts folder

More:
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Restart Compose
To restart the compose of any message saved to a draft folder, expand the draft folder and either 
double click on the appropriate draft message or, from the Message Menu select Restart 
Compose. This will start a Restart Compose window, placing the entire draft message, including 
any addresses or attachments, into the window and allow you to continue.

Double-clicking on any draft icon will place 
that message into a Restart Compose 
session. The message does not have to be in 
the drafts folder.

Using the Submission Manager
If you are continually sending large messages or messages with large attachments the 
submission manager may be a sending alternative. Basically, setting up Simeon Mail to use 
background send will send all outgoing mail to your queued messages folder, usually outbox. 
These messages will then be sent by the submission manager. This is extremely useful since 
sending mail in the foreground takes up valuable time in that access to Simeon Mail and its 
features is denied when the send is processing.

If background send has been selected under Tools/Options/Edit/Send then all outgoing 
messages go to the outbox folder. When the submission manager detects messages in the 
outbox folder it will send these messages in the background thereby not tying up valuable time.

Note    Do not confuse the submission manager with sending queued messages. The submission 
manager will only start if the option Background send has been selected from 
Tools/Options/Edit/Send. While queued messages can be sent in the background, this is a 
menu item under Compose/Send Queue Background not a default for all message detected in 
the outbox folder.



Compose Window Options
There are numerous options available to deal with mailed messages. These range from setting 
the message priority, to the disposition of the Compose window after a message has been sent.

All global or default options related to the priority, receipt, saving and queuing of messages are 
accessed through Edit/Compose under the Options menu (see Compose Options). These 
options are also available on an individual compose session basis either through 
Compose/Options menu item or the Option button on the toolbar. You may, for example, have a 
read receipt set for the current message only or can change the priority of that message only. 

On first accessing the compose session options 
either through the Option button or 
Compose/Options menu, it will have the defaults 
as set out under Compose/Edit/Options.

Figure 41 Compose Session Options Window

More:
Read Receipt
Delivery Receipt
Saving the Outgoing Message
Queue Message
Message Priority
Disposition of Compose Window



Read Receipt
By selecting Read Receipt from the Compose/Options menu you will be informed of the date 
and time when the addressee has opened this particular message. If you frequently require read 
receipts for messages you send a default can be set under the Tools/Options/Edit menu in 
Compose. It is not recommended that you set this default if your mail list is extremely large, since
you would receive a receipt for each individual you mail.    Please see Compose Options for more 
information on read receipts.



Delivery Receipt
By selecting Delivery Receipt from the Compose/Options menu, you will be informed of the 
date and time when the mail was successfully delivered to the addressee.    You can choose to 
have this feature as a default by setting it in Compose under the Options/Edit menu.    Again, 
using this is not recommended if you have large mail lists. Please see Compose Options for more
information on delivery receipts.

You are not guaranteed that the recipient's system is capable of returning information regarding 
the status of messages received by them.



Saving the Outgoing Message
Simeon Mail has the ability to keep copies of sent messages in much the same way as paper 
copies are kept in a file. However, to retain a mail message, a folder must specified and created 
for the purpose of retaining these messages. A default folder name of sentmail has been specified
under the Options/Compose from the Tools menu.    For information on changing the sentmail 
folder location please see Compose Options.

When Save Message is selected under the Compose/Options menu, the outgoing message will
be saved to the folder you have specified in Compose also under the Options/Edit menu. This 
sentmail folder may contain message groups to allow you to organize your saved mail.

Your sentmail folder can grow very large in a short time frame if you are saving all outgoing 
messages. Therefore, you should periodically clean old and unwanted messages from the 
sentmail folder. 



Queue Message
An option that is particularly useful when you are not connected to your network server is    the 
ability to write and store messages for sending at a later time.    Simeon Mail has this ability to 
keep a message or number of messages in a predefined folder until you wish them to be sent.    A
default folder called outbox has been created in the Local Folders Message service for messages
that have been queued for sending at a later time. The location of the outbox should be on a local
Message service (i.e. stored on your hard drive) since it is assumed that this feature would be 
used when you are disconnected from your network. If you wish to change the default location 
please see Send Options.

If you would like to use this feature for only a select few messages the option can be toggled for 
individual messages in Options under the Compose menu. Messages that are to be mailed at a 
later time are toggled as queued by selecting Queue Message from the Compose/Options 
menu when in the compose session.      When you press the Send button or select Send from the 
Compose menu the message will be directed to your outbox folder.    

This function can be used when you are connected to a network, but remember that the folder 
that will retain these messages must still be specified in a local Message service.

More:
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Sending Queued Mail
Once you have reconnected to your network the mail stored in outbox can be sent at anytime by 
selecting Send Queued Messages Now from the Compose menu.



Message Priority
Simeon Mail provides you with the ability to indicate the urgency of all mail sent to the person 
receiving your mail. The pre-set default for message priority is normal, which produces a black 
colored priority header in the message group. To modify the priority of an individual message, 
simply select the desired priority from the Compose/Options menu while composing the 
message.    The priority may be changed to either urgent (usually red text), normal (usually black 
text), or low (usually green text) priority.

To change the pre-defined default select Compose under the Tools/Options/Edit menu and 
choose a preferred default priority. For a full explanation on changing the default priority please 
refer to Compose Options.    If you wish to modify the colors of each of the priority levels please 
see Font Options.



Disposition of Compose Window
The three options related to the disposition of the Compose window after a message has been 
sent are:    Close after Send, Clear after Send, and Remain after Send.    To set one of these 
options for an individual message, look under the Compose/Options menu and click on the 
desired option.    If you prefer to set one of these options as a default, please see Compose 
Options.    Below is a brief description of the function of each option:

Close After Send: This option will close the Compose window after the Send button has been 
selected.

Clear After Send: Selecting this option will clear the Compose window of the current message 
after clicking on Send leaving the actual Compose window on your screen ready for another 
message.

Remain after Send: This option will leave the Compose window intact with the current sent 
message still visible in the window.    This feature can be useful if you will be mailing a similar 
message to a number of recipients.



Edit With...
You may choose to use a different editor, such as Microsoft Word or Notepad, rather than the one
provided by Simeon Mail. If this is the case, take the following steps:

1. With a Compose window open, select Edit With.. from the Compose menu and navigate to 
the editor you wish to use (e.g.    Microsoft Word). This will bring up the chosen editor, 
allowing you to compose the message. 

2. When you have finished, exit the editor and confirm that you wish the file to be saved to the 
temporary filename given upon exit. Remember that the file is to be saved as text only since 
special formatting codes specific to that editor will not be available in the Compose window.

3. Fill in the envelope section of the Compose window and click on Send to include the 
temporary file in the outgoing message.

If you have already started composing a message in the Compose window before selecting an 
editor, that portion of the message will automatically be included in the editor window.    



Sending Mail Outside of Simeon Mail
Another feature, similar to using an external editor, is the ability to send a message from any 
Microsoft software that has a "Send" option.    To use this feature, simply compose a message 
and select the Send menu option; normally this option will be located under the File menu.    Your
message will then be an attachment to a Compose window in Simeon Mail. Filling out the 
envelope section and clicking the Send button will complete the mailing process.

If a full workstation installation has been done you will not need to make any changes. However, if
you are running Simeon Mail over the network, in order to access this feature certain changes 
must be made to your win.ini file. As well, certain files must be copied from the Simeon Mail 
application directory to your c:\windows directory.

More:
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Editing the win.ini File
In order for outside send to work, your win.ini file must be edited to include the following lines:

[Mail]
MAPI=1
MAPIX=0
[SIMEON]
PATH=c:\fullpathname\toSimeonExecutable
WORKDIR=c:\workingdirectory\onlocaldrive



Copying Files
If you have done a full workstation installation and have selected MAPI as part of the installation 
package, no files will need to be copied to your workstation. If, however, you are on a network 
and have set up your own Program Group you will need to copy certain files to your workstation. 
These files will reside somewhere on your network in the Simeon application directory.

More:
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Simeon 16 bit Version
If you are running a 16 bit version of Simeon you will need to copy a file called mapi.dll from 
the Simeon application directory to your c:\windows\system directory.



Simeon for Windows 95
If you are running Simeon Mail for Windows 95 you will need to copy two files, mapi.dll and 
mapi32.dll from the Simeon application directory to your c:\windows\system directory.



Simeon for WindowsNT
If you are running Simeon Mail for WindowsNT you will need to copy two files, mapi.dll and 
mapi32.dll from the Simeon Application directory to c:\winnt35\system32.



Replying to a Message
It is often necessary to reply to mail messages. Using the reply facility in Simeon Mail will make 
replying to these messages easier. For instance, the name of the person who originally sent the 
email is automatically entered in the To: field. As well, users have the option of replying to all 
recipients of the original mail or to the sender only.

To reply to a message, click on the Reply button 
in the toolbar or select Reply from the 
Message menu.

Once Reply has been selected Simeon Mail will ask you to choose whether the reply is sent to 
just the sender or all recipients of the message.    If you prefer one of the options or do not wish to
be prompted for every reply you make, the default setting can be accessed under the 
Tools/Options/Edit menu in the Reply window.    Once this selection has been made or if you 
have set the Reply options default, the following window will appear on your computer.

Figure 42 Reply Window

Simeon Mail inserts the appropriate information in the To, Subject and Cc boxes. Assuming that 
you have chosen to include the original text in the reply, Simeon Mail then inserts the original 
message in the Message Text window. 

Once the text has been inserted you have an option of what to do with the included message. In 
some cases, you may want the message to remain intact with a specific reply at the top or bottom
of the message. In some cases you may wish to annotate portions of the message, giving your 
responses to questions or issues within the body of the included message. Do not be afraid to 
delete sections of the original text. Not everything included in the original message will be 
applicable to your reply. Since each line of the original message is preceded by the symbol 
selected through the Tools/Options/Edit/Reply window, your message will be easily discernible 
from the original.    Remember that all messages replied to will have an "R" next to the opened 
envelope or box icon in your Message Organizer.

Attachments are not included in the Message Text window. Only that portion of the message that 
is plain text will be included. In order to include the original attachment in the Reply message it 
must first be saved to a file and then re-attached.



For a more detailed explanation of the reply options please see Reply Options.



Forwarding a Message
It may be necessary to forward received messages to other people. Messages may be forwarded 
to anyone with an email address.

To forward a message select the appropriate 
message from within the message group and 
then the Fwd button or Forward from the 
Message menu. The following Forward 
window will appear on your computer:

Figure 43 Forward Window

The subject line is automatically inserted from the original message with a <fwd> designation.    It 
will be necessary to complete the remainder of the envelope section. The original message with 
the original envelope information will be included in the Message Text section. The message may 
be modified as necessary or personal comments may be added. Forwarded mail will include all of
the original attachments.



Introduction
Simeon Mail can move or copy a message or group of messages in a number of different ways. 
This is accomplished either through drag and drop or the menu system. Messages can be moved
or copied to other folders or message services as:

· a single message or block of messages from one folder to another within the same message service;

· a single message or block of messages from one folder to another within a different message service;

· a message group so that the messages contained in the message group become part of another 
folder in the same message service;

· a message group so that the messages contained in the message group become part of another 
folder in a different message service;

· a folder so that is becomes a sub-folder of another within the same folder;

· a folder so that is may reside in a different message service.

Some of the ways this can be useful are:

1. If working offline it enables you to move the contents of a pertinent folder to a message service stored
locally on your C:\ drive then return it to the original network message service when reconnected.

2. It allows you to organize your messages by moving folders so they become sub-folders thereby 
creating a folder hierarchy.

3. The messages contained in a message group can be moved or copied to another folder. This is very 
useful for collecting messages in your inbox folder and moving them to another folder for archival 
purposes.



Parent and Child Objects
Quite simply a parent object is any object which contains another object within it; the child is that 
other object contained therein. For instance, any sub-folder is considered a child of its 
immediately containing folder (called the parent); any message group is considered a child of its 
containing folder and any message is considered a child of its containing message group (or 
folder if message groups are not being viewed).



How the Move/Copy is Done
When Simeon Mail gets the command to move or copy an object from one location to another it 
looks to the source and destination to determine if this type of move or copy is allowed. For 
instance, moving a message from one message group to another within the same folder is not 
allowed since the sorting criteria used for message groups within that folder will take precedence 
over the move. However, moving a message from a message group in one folder to another 
folder will work. Below is a table that helps explain the relationship between the source object and
the destination.

Source Destination

Folder Message 
Group

Message Message 
Service

Folder will 
become a
sub-
folder

will 
copy/move 
to parent 
older

will copy/ 
move to 
parent 
folder

will copy/move 
as child folder 
within 
message 
service

Message 
Group 
(messages 
only)

will be 
containe
d in 
folder *

will be 
contained in 
parent folder
*

will be 
contained 
in parent 
folder* 

N/A

Message(s) will be 
containe
d in 
folder *

will be 
contained in 
parent folder
*

will be 
contained 
in parent 
folder*

N/A

Search Folder
(selected 
messages)

will be 
containe
d in 
folder

will be 
contained in 
parent folder

will be 
contained 
in parent 
folder

N/A

* Note    In these cases the destination folder cannot be the same folder as the object's source 
folder.



Moving and Copying Search Folders
A search folder cannot be selected and moved or copied. The individual messages or the entire 
group of messages within the search folder must first be selected then the copy and move 
functions will become available. Moving or copying the contents of a search folder acts in the 
same manner as moving or copying messages.



General Move Rules
A move is accomplished by selecting one or more objects and either using drag and drop to move
them to their new location, the Move button on the toolbar or the appropriate menu item.

More:
Moving Objects using Drag and Drop
Moving Objects Using the Menu



Moving Objects using Drag and Drop
To move any object from one location to another using drag and drop:

1. Select the object.

2. Drag the object over the desired destination and release the mouse button.

Note    Additional objects may be selected using the CTRL key or a block of objects selected using 
the SHIFT key.



Moving Objects Using the Menu
You may also move an object to another location by using the menu system. The menu item 
depends on the object selected.

Object Selected Menu Item

Message Message/Move to Folder

Folder Folder/Move to Folder or Folder/Move to Message Service

You may also move an by selecting the object or 
objects and clicking on the Move button on the 
toolbar.

General Copy Rules 
A copy is accomplished by selecting one or more objects and either using drag and drop to copy 
them to their new location or the appropriate menu item.

More:
Copying Objects using Drag and Drop
Copying Objects Using the Menu



Copying Objects using Drag and Drop
To copy any object from one location to another using drag and drop:

1. Select the object with the CTRL key depressed, keeping both the mouse button and the CTRL 
key depressed.

2. Drag the object over the desired destination and release both the CTRL key and the mouse 
button.

Note    Additional objects may be selected using the CTRL key or a block of objects selected using 
the SHIFT key. Remember that the CTRL key must be pressed before the drag and drop is started.



Copying Objects Using the Menu
You may also copy an object to another location by using the menu system. The menu item 
depends on the object selected.

Object Selected Menu Item

Message Message/Copy to Folder

Folder Folder/Copy to Folder or Folder/Copy to Message Service



Move and Copy Cursors
During a drag and drop move or copy, Simeon's cursors will let you know what action is taking 
place and whether the target is valid. 

Indicates a drag and drop that will copy the selected 
objects. The cursor illustrated here shows a message 
being copied. The cursor will change depending on the 
object being moved and will show folders, messages 
with attachments and groups of messages.

This cursor indicates that the drag and drop action is to
move the selected objects. Again, the cursor will 
change to either folders, messages with attachments 
or groups of messages depending on the object 
selected.

Invalid "drop" locations are indicated by a circle with 
a line through it.

Note    You may not drag and drop messages between message groups located in the same 
folder. This is because the messages will remain organized in the manner dictated by the setup in
each message group.



Introduction
PGP, or Pretty Good Privacy, allows you to send and receive private email.    You may already 
think that your email is completely private but that may not be. Any information sent over the 
Internet, through email and from bulletin board services has the potential of being read by others. 
We can't do much about the bulletin board services or the World Wide Web but we can make 
your email more secure.

For the most part no one has to worry about their email being read. Let's face it, email isn't that 
interesting except for those actually carrying on the email conversation, called a "thread".    There 
are exceptions to every rule. If you are confirming a salary increase both parties would like 
privacy; if you are closing a big sales contract both parties would like privacy. The list goes on.

This section is not designed to lead you through a PGP installation or view the contents of your 
key ring. It will show you how to create your own public and private keys, share your public key, 
add other user's public keys to your key ring and send and receive PGP encrypted mail through 
the Simeon Mail interface.

If you would like further information on PGP, ways of obtain a copy of PGP please search the 
World Wide Web. We suggest you start here:

http://www.yahoo.co.uk/Computers_and_Internet/Security_and_Encryption/
PGP___Pretty_Good_Privacy/ or http://www.pgp.com

Remember    PGP is a DOS application and must abide by the rules of DOS. When installing 
PGP please note that due to these restrictions it must be at the root of your C: drive. In addition, 
on Windows 95 or NT installations, neither PGP nor Simeon can reside in the default location 
directory Program Files.



PGP Capabilities
PGP will not only ensure that the mail sent and received is not read by others but that it really is 
from the sender as stated in the message. To do this, PGP uses a form of public key 
cryptography. It uses a two-key system; a public key and a private key. The public key is 
distributed publicly to your fellow email correspondents while the private key is kept by you to 
decrypt any PGP encrypted mail received. Encryption can be used on the message itself or on 
the signature (used to verify authorship) or both. PGP does not make any guarantees as to the 
authenticity of any public key received.

Note    When you are using PGP within Simeon Mail you will be accessing a DOS window within 
which PGP will ask for certain information. Due to the variety of PGP products and versions 
available it is difficult to cover all possibilities.

More:
Generating Your PGP Key
Publishing Your PGP Key
Capturing Another User's Public Key
PGP Sending Options
Decrypting Received Messages



Generating Your PGP Key
To generate your own public/private key combination select PGP/Generate Public/Private Key 
from the Tools menu. This will open a DOS window and guide you through the steps to generate 
your key combination. It is suggested that you use option 3, military security, to generate your key
(military security uses an extremely high level encryption algorithm and is considered the most 
secure). After you have run through the steps to generate your keys you should now publish your 
public key by sending it to those individuals to whom you will be corresponding using PGP 
encrypted mail.



Publishing Your PGP Key
Selecting Publish Public Key from the Tools/PGP menu will place your public key into a 
compose window.    Address the message and click on Send and the recipient will then be able to
capture your key. The Compose window may resemble:

Figure 44 Publishing Public Key Window

Note:    You may add any message to the Compose window as long as it appears before or after 
the public key block.



Capturing Another User's Public Key
When you receive another user's public key open the mail message and go to 
Tools/PGP/Capture Public Key.    PGP will ask you to verify the public key and will then add it to
your keyring.



PGP Sending Options
Two sending options exist with PGP: sending encrypted messages or digitally signing your 
outgoing messages. Both of these options are available only in a compose situation either 
through the Compose/Options menu or the Option button on the toolbar. When sending any 
message using PGP you may use either one or both of these options.

Figure 45 Compose Options for PGP



Decrypting Received Messages
Received PGP encrypted messages will resemble the following:

Figure 46 PGP Encrypted Message

The options to decrypt PGP encrypted messages are all available through the Tools/PGP menu 
and are:

1. Decrypt: this will decrypt the message and put it in a viewer window. Messages will need to 
be decrypted each time they are viewed. As well, messages cannot be saved to file 
decrypted.

2. Verify Signature: this option will verify that the signature contained in the email message is 
authentic. Authenticity is only determined against the public key signature already received 
from that individual. This feature only applies to digitally signed messages.



Introduction
Simeon Mail has the ability to search through any number of folders for specific messages sent or
received by you. Searching is an extremely powerful tool to retrieve messages meeting a certain 
criteria and bundle them into a central location for review or action.

Searches can be used to plan for offline work, collect messages regarding a certain subject 
matter, from a specific person or during a specific time frame. They can be general (all messages 
received from "Joe") or very specific (all messages received from "Joe" regarding the "budget" 
since "December 15, 1996").



Types of Searches
Quick Search and Advanced Search: both are the same. Each takes a one or more folders and 
searches the messages contained in that folder for a match. Each creates a search folder 
containing all messages that meet the criteria. The difference is the ease. Quick searches supply 
a template to choose your search criteria; Advanced searches allow for a powerful way to build 
more complicated searches.



Quick Search
The quick search facility allows you to search for a specific phrase using a pre-designed form for 
ease of use. It is designed to give you a general base to start the search process.

After selecting the folders to search, clicking on 
the Srch button or selecting Search from the 
File/New menu allows you to define your quick 
search.

Figure 47 Quick Search Window

The quick search window has three main areas which are described below:

Messages: The Messages section tells Simeon Mail what type of message to search through. 
The options are read messages, unread messages or all messages in your selected folders.

Arrival Time: This section determines the dates of the messages you wish to search through. 
The options are: Within one day of search time, Within one week of search time or All messages 
in the selected folders.

Keyword Search: In this section check the various parts of the messages you want to search 
and input the text string you wish to search.

More:
Search Example



Search Example
The following examples show how a search is constructed and how the results of that search will 
be displayed: 

Figure 48 Quick Search Example

The quick search example above requested all messages from Joe Doe that have been received 
within the last week to be located and isolated for review.

Figure 49 Quick Search Results

Rule    Upon selecting a folder for a quick search please remember that any sub-folder will not be 
searched for message matches. A quick search will only search messages in a selected folder, 
not the hierarchy.



What Happens to the Messages Found?
When a search is performed, whether a quick search or advanced, a search folder is created in 
your Message Organizer. This search folder contains the original message. It does not contain a 
copy of the message that resided in the folders that were searched. Anything you do to a 
message in a search folder will affect your mailbox.

All messages in your Post Office message service are stored on a server somewhere on your 
network. This is called the message store. Simeon Mail does not copy messages it finds through 
searches into a search folder; rather it isolates these messages for your viewing convenience.

Figure 50 Relationship of Search Messages

More:
Rules About the Disposition of the Messages Found



Rules About the Disposition of the Messages Found
As mentioned, the messages found in a search folder are simply an additional pointer to the 
original message residing in your message store. Because of this certain rules apply to the 
messages in search folders that affect their folders of origin:

· deleting messages from a search folder will also mark those messages deleted in the originating 
folder;

· cleaning a search folder will also clean all messages marked for deletion in the originating folders 
regardless of whether they reside in the search folder;

· you cannot move or copy messages into a search folder;

· you will not be able to move or copy the search folders. You must first select the appropriate 
messages within the search folder then either move or copy.



Advanced Searching
While the quick search will give you an easy, fast way of accessing very specific messages in 
your folders, an advanced search will give you even more control on the type of messages you 
want to retrieve.

Advanced searches have the flexibility to look for messages before, after or during specified 
dates, messages with special status and priority, messages that follow a specific subject matter or
all of the above, just to name a few.



Beginning an Advanced Search
Before we get into actually constructing an advanced search there are a few steps to follow, some
rules to keep in mind and some planning to do. It sound a lot more complicated than it actually is 
but you must remember, advanced searching is an extremely powerful tool. It is entirely possible 
that you have several hundred messages in your folders, both local and remote, and want to 
search for a specific subject thread. Something like looking for a needle in a haystack. If you 
remember to plan a little you'll have no trouble:

· What folders are relevant to my search?

· Do I need to search in other message services as well?

· What type of message am I looking for? what time frame? who are the authors or recipients 
involved? what is the subject matter?

Chances are you already know the answers to these questions—it just doesn't hurt to be 
reminded.



Building an Advanced Search
Once you have decided what you need to search the time has come to build the advanced 
search.

The first thing to do is select the folders that you will be searching. These folders may be in any 
message service to which you have access, either local or remote. After the folders have been 
selected choose Search from the File/New menu or click the Srch button on the toolbar to 
access quick search window. Next click the Advanced button to obtain the following search 
properties window:

Figure 51 Search Properties Window

The Search Properties window is the first step to defining a search. It allows you to name the 
search, choose the sort order, decide if you want to view message groups within your search 
results, add or delete folders to be searched, count the number of folders that will be searched 
and choose existing search rules or define additional search rules. Last comes the "sanity check":
you are able to select the search rules and do a pre-search count to determine the number of 
messages that would be retrieved if the search had actually been performed.

Naming the Search: searches can have any name you choose. If you leave the search with the 
default name Search#, that search will be temporary and deleted upon exiting Simeon Mail. Only 
the search will be deleted, the messages will remain in their original folders.

Sort by: Similar to the sorting used for folders and message groups, the Sort by box allows you 
to sort your search by date received or sent in either ascending or descending order, or sort on 
the From or Subject field.

View message groups: Like folders, search results can contain message groups. Initially, the 
search result will only contain the Main and Deleted message groups, however, additional 
message groups can be added. For more information on creating a message group please refer 
to Creating a Message Group.

Search Folders: This field will list the folder(s) that you have initially decided to search. You can 



add or delete folders using the respective Add Folder and Delete Folder buttons. If you have 
selected Search Hierarchy all sub-folders will also be searched and you will not need to select 
each one individually.

Search Hierarchy:    Selecting this option tells Simeon Mail to search the hierarchy of the folders 
listed. In other words, all sub-folders of the named folder will also be searched for messages 
matching the search criteria.

Search Subscribed Only: If you have selected a main folder that has subscribed and 
unsubscribed sub-folders, only those folders to which you have subscribed will be searched. 

Count Folders: Click on this button to count the number of folders that will be searched. It is very
easy to choose three folders only to find out that they contain 250 sub-folders between them. 
Since there is a limitation of 40 folders that have a connection at any one time, and Simeon must 
open a connection to the folder in order to search its contents, it is important to know how many 
folders you'll be searching. If a folder contains no messages meeting the search criteria that 
connection will be closed and will not be counted as one of the 40 available connections.

Search Rules:    The Search Rule area is the area that actually defines what you are looking for. 
In this section you can choose to search using one or more of the existing rules, or use the 
Define Rule button to create new rules or modify existing rules. 

Search Count: If you want to run a test of your search click on the Count button. Simeon will let 
you know how many messages will be identified using the existing search rules. Depending on 
the answer, you can then narrow or expand your search or click OK to proceed to collect the 
messages. 

Note    The search count feature is not necessarily a time saver as Simeon Mail must actually 
perform the search in order to give you the results.



Defining a Search Rule

Figure 52 Define Search Rule Window



Target
The target is an object you are looking for. In the case of advanced searches, the object or target 
is a message.



Rule Name
The name given to a specific search rule.    On clicking on the New button, the rule name will be 
set out as Rule#. You may rename the rule name to better reflect the context of the search to be 
performed.



Search Phrase
The search phrase consists of an attribute and possibly criterion and one or more parameters. 
One or more search phrases comprise a search rule.



Attribute
Attributes consist of a predefined list of possible search areas that act as the basis for creating 
search phrases. Attributes may act with or without criterion.



Criterion
Criterion is a list of predefined standards that determine how an attribute is used. For example, an
Attribute of "send date" may have a criterion of "after". All criterion require a parameters. 
However, not all attributes require criterion.



Parameters
Parameters are the boundaries specified for qualifying an attribute and criterion. Parameters may 
be dates, word strings, etc. and will change depending on the criterion chosen.



Search Rule
The search rule box contains the list of search phrases that comprise the rule. Each phrase may 
edited or removed from the search rule or all phrases may be removed from the search rule box.



Edit
Selecting a specific search phrase from the list and clicking Edit will place it back in the Search 
Phrase portion of the window allowing you to modify the contents of that search phrase. Click on 
Add when the changes are made to place it back in the Search Phrase box.



Remove and Remove All
These buttons will either remove the selected search phrase from the list or, in the case of 
Remove All, delete all the search phrases from the Search Phrase box.



Modify
If a name has been specified in the Rule Name box then you can click on the Modify button. This 
will active this search rule allowing you to edit, add or remove individual phrases or remove all 
phrases for this search rule. It will also active the Delete button so you can delete this search 
rule.



Advanced
The Advanced button allows you more sophisticated searching capabilities using the IMAP 
language.

Note:    Once a search has been executed it will not be updated automatically as new mail 
arrives. As new messages arrive in your folder rebuild the search so your search folder is up to 
date. 



Rules about Search Rules
To understand more about search rules here are few rules about what they are and what they are
capable of:

· There are quick rules and advanced rules.

· Rules may be temporary or permanent. 

· Changing the rule name from that assigned by Simeon changes the status from temporary to 
permanent.

· Rules may be shared between folders and other searches.

· Rules are made up of one or more phrases. Each phrase is joined by AND. In other words 
each phrase in a rule must be met to collect the message.



Permanent and Temporary Searches
Initially all searches created are temporary. That is to say, upon exiting Simeon Mail the 
messages remaining in a search folder upon logging out stay in their original folders and the 
search folder is deleted. Temporary searches will be named Search#.

To make a search permanent:

1. select the search;

2. click on the Info button or choose Properties from the File menu;

3. in the name field select the existing name, Search#, and replace it with a new name.



Deleting a Search
Search folders can be deleted in the same manner as any other object by either choosing Delete 
from the File menu or the Del button on the toolbar. Deleting a search folder gives you three 
choices. You may either:

· delete the search (this will keep all messages in their originating folders);

· delete the messages contained in the search (this will mark them for deletion in their originating 
folders); or

· cancel the operation (leave the search and messages intact.



Managing your Folders through Searching
It is possible to filter the messages viewed in any folder through the search facility available in 
Simeon Mail.

More:
Filtering the inbox Folder (example)
Defining a Search Rule



Filtering the inbox Folder (example)
Typically your inbox folder should be lean. Any messages worth keeping should be moved to 
another folder either in your Post Office message service or Local Folders message service. 
Sometimes that isn't possible or desirable. When this is the case you can set up your inbox folder 
to only retrieve certain messages.

First, your folder properties window should have the Selected radio button checked and resemble
the following:

Figure 53 inbox Folder Properties Window

Hint    Any folder in your Message Organizer, whether local or remote, can be managed by 
attaching search criteria. Any time you wish to view all messages in the folder simply ensure that 
the All radio button is selected.



Defining a Search Rule
In this example for filtering the inbox folder, once the Selected radio button is chosen the Search 
Rules box is available and you may define your search. This process is much the same as in 
Defining a Search Rule. The exception is that in our example only messages from a certain time 
period will be retrieved. These messages may be those with the new flag (those messages 
received since the last time you accessed your inbox) or the recent flag    (messages with the 
new flag and those messages added to your inbox the last time you accessed mail). Alternatively,
you may also set a specific date, say messages received within the last week. If you set a search 
using this criteria you should change the date at least weekly.

The following window shows a search rule built based on retrieving messages with the recent 
flag. Notice that the search has been named so that it will not be deleted upon exiting Simeon 
Mail.

Figure 54 Sample inbox Filter

Note    If you clean messages from a folder that has a search attached you will not only clean 
messages currently in the Delete message group but also all messages that are marked as 
deleted but are not being displayed in your folder due to the nature of your search. This is 
because the Simeon Mail still has access to all messages on your server you have just opted to 
display certain messages.



Commonalities between Search Folders and Mail Folders
Search folders and mail folders have much in common. They both:

· contain messages,

· may contain message groups,

· have a specified sort order,

· share search rules,

· share common operations such as viewing, deleting, moving and cleaning mail.

The difference is how dynamic a folder is compared to a search. In order for a folder to update all 
that is necessary is that new mail is received. A search, however, must be re-executed in order for
any new mail being received to be filtered into that search.



Introduction
Simeon session management is an extremely powerful tool used to manage any situation you 
may encounter with Simeon Mail. Session management allows you to process mail without 
necessarily having access to your message store. Generally, session management is required if 
you work on a laptop from various locations. You may be in the office, at home, in an airport or 
hotel.

All in all the session management gives you the opportunity to work from anywhere, at anytime, 
with any configuration.



Session Management Definitions
Online vs. offline; configuration specifications vs. configuration options. These are the terms that 
make session management work.

Configuration Options is the set of user options as defined under Tools/Options/Edit. These 
options provide individual users with a personalized workspace.

Configuration Specifications are set out in the simeon.ini file located in your Simeon Mail 
working directory. This file sets out whether your default login is IMSP or local .tcl, and records 
the name of each configuration option set you have stored for access during login using the 
Session Manager.

Offline refers to limited access to Simeon Mail's capabilities. Offline allows you to process your 
mail rather than have full access. Any email that you have collected and stored locally on your 
hard drive will be available to process—read, reply to, forward, send.

Online refers to Simeon Mail sessions where you are connected to your network and have full 
access to all configuration specifications, your full message store and all of Simeon Mail's 
capabilities.

Session Manager is the system used to access the various configuration options created for 
online or offline access.



Accessing Different Configurations of Simeon
The first time you access Simeon Mail you will be asked a few questions regarding your mail 
environment. These questions deal with who you are and what hosts you will be accessing for 
your mail and address books. With the exception of your identity, your System Administrator will 
usually provide the host names for you or complete this information beforehand. Once this setup 
procedure is completed it will act as your default. Every time you log into Simeon Mail this 
configuration will be your setup. However, with the advent of home computers and laptops you 
may not have access to or want to access the same configuration each time. 



Configuration Storage
Local or Remote? What's the difference? Simeon Mail can store your configuration anywhere; in 
any location on your hard drive (local), in a specific location anywhere on the network (local or 
remote) or on a specific mailhost (remote). Not only can Simeon Mail store your configuration in 
these locations, the Session Manager allows Simeon Mail to store numerous different 
configurations in each location. The number of different configurations depends on your needs.



Command Line Arguments
Simeon Mail's command line arguments start Simeon in a predefined operational mode. They can
make Simeon Mail easier to use.

More:
-r remote_host
-n remote_tcp_port
-f config_file
-u userid -p password
-m mandatory remote
-s (suppress)
-c connection_mode



-r remote_host
simeon [-r remote_host]

The -r remote_host argument (where remote_host is the hostname of the server where user 
configuration options reside) directs Simeon Mail to load the configuration options resident on the 
specified remote host. If Simeon cannot connect to this host look for the default configuration file 
in your working directory, usually called default.tcl. If this file does not exist Simeon Mail will use 
its startup mode to configure a new environment.



-n remote_tcp_port
simeon [-n remote_tcp_port]

The -n remote_tcp_port argument (where remote_tcp_port is the port number of the remote 
configuration options server) directs Simeon Mail to read from this port number rather than the 
default port of 406. If a configuration options file does not exist on this alternate IMSP service, 
Simeon Mail will look for the configuration options in your working directory, usually called 
default.tcl. If this file does not exist Simeon Mail will use its startup mode to configure a new 
environment.



-f config_file
simeon [-f config_file]

The -f config_file (where config_file is the name of your configuration options file) variable will 
direct Simeon Mail to look in a specific location on your network for your configuration options. It 
is recommended that the path to this file be absolute (e.g.: c:\simeon\work.tcl rather than 
just work.tcl).



-u userid -p password
simeon [-u userid] [-p password]

The -u userid and -p password (where userid is the name of the user and password that you will 
login as) will log on to Simeon Mail the specified name and password. This is a time-saving 
device generally used to bypass the initial login screen. For security reasons it is not 
recommended.



-m mandatory remote
simeon [-m mandatory_remote]

The -m will force Simeon Mail to connect to a remote IMSP configured server. If a server cannot 
be found to access configuration options, Simeon Mail will exit.



-s (suppress)
simeon [-s suppress] 

The -s will suppress the loading of your desktop configurations.    This can be helpful if you would 
like to start with a generic desktop and modify it to suit your present needs.



-c connection_mode
simeon.exe -c d
[disconnected]

directs Simeon Mail to operate in offline 
mode. Used when you cannot or do not 
want to connect to your network.    

simeon.exe -c c
[connected]

directs Simeon Mail to operate in online 
mode.    Used when you can contact your 
network.

Configuration Load Order
Simeon Mail determines your configuration needs based on the command it is given. First, 
Simeon Mail looks for a command line argument. If Simeon Mail finds no command line 
argument, it will go directly to the simeon.ini file found on your hard drive in the Simeon Mail 
working directory to determine which configuration file is used as the default startup configuration.
This configuration file may be either local or remote.



Loading Configurations with the Session Manager
-c prompt_connection
Accessing the Session Manager



-c prompt_connection
simeon [-c prompt_connection] 

This command line argument is probably the most powerful. It will modify the Simeon desktop to 
represent operations in offline or online mode and allow you to load any one of your 
configurations on startup.

simeon.exe -c p causes Simeon Mail to prompt for the operational mode you prefer.    You 
can select between online or offline mode and choose the configuration 
options file that will be loaded on startup. You will prompted with the 
following window:

Figure 55 Session Manager Prompt

From this dialogue you can choose to work online or offline and choose the configuration you 
wish to load for this session of Simeon Mail. If you require more information on a specific 
configuration, the More… button will provide a screen outlining the parameters of your 
configuration specification that may be similar to the following:

Figure 56 Configuration Information



Accessing the Session Manager
Each time you save a new set of configuration options under Tools/Options/Save As Simeon 
Mail will add this to your configuration specifications file, simeon.ini, in your working directory 
for access. You can access these configurations during login or after login by accessing the 
Session manager under Tools/Options/Load. 



On Demand Online and Offline
Another way of using Simeon Mail in online or offline mode is through the menu item Go Online 
or Go Offline available under the File menu. This will change your desktop depending on your 
choice. Below is a table illustrating what services are available for online and offline:

Function Offline Online

Searching local folders only all folders

Folders folders under local message 
services only

all folders

Public Directory unavailable available

Addressbook 
Organizer

local address books only all address 
books

Message Queuing available available

Sending Mail available through queuing available

Receiving Mail unavailable available

Forwarding Mail available through queuing available

Replying To Mail available through queuing available

Reading Mail available in local message 
services only

available

More:
Using Offline in Online Mode



Using Offline in Online Mode
You've logged in, finished composing a message but for one reason or another cannot send the 
message now. Perhaps the message must be time stamped after a certain time; perhaps your 
link to the outside world just disappeared and saving to drafts folder is not an option since the 
message really isn't a draft. In this case you can change your mind using the compose session 
Options window.

Figure 57 Compose Session Options Window Queuing Message

Select Queue Message and click OK. After clicking on Send your message will be saved to the 
folder you've designated for saving queued messages, usually outbox on your hard drive. Again, 
the location of the outbox folder is determined under Tools/Options/Edit/Send.

When you are reconnected to your network you may select Send Queued Messages Now  from 
the Compose menu.    If you have logged the next time you access Simeon Mail in online mode it
will recognize that there are messages in the outbox folder and ask if you wish to send them.

Figure 58 Sending Queued Messages Window

You have the option of sending these messages now or canceling the send and sending through 
the Compose/Send Queue Now menu item at a later time.

Also available is the Compose/Send Queue Background. This menu item will send messages 



detected in your outbox folder using the submission manager. The submission manager works in 
the background allowing you full access to Simeon Mail. If you have a large number of messages 
in your outbox folder you may wish to use the background method so that you can still read, 
compose and manipulate your mail.



Introduction
The Addressbook Organizer contains any number of address books each containing a list of 
names along with the corresponding email addresses of those people to whom you might send 
mail. But they are not only for email addresses. Address books have the ability to store and 
retrieve street address information, phone numbers and any number of additional information that
is configurable on an individual basis. 

Address books may reside on a remote server or on your local hard drive. Your list of address 
books will not only contain books created and maintained by you but may also contain address 
books that other users are sharing with you.

Address Books can store the email addresses of individuals either separately or in lists for easier 
access.



Accessing the Addressbook Organizer
To access the Addressbook Organizer, click on 
the Addr button on the toolbar or select Open 
Addressbook Organizer from the Address 
menu. This will display the following window.

Figure 59 Addressbook Organizer Window

Once the Addressbook Organizer has been accessed, your personal and local address books will
appear in the window. The personal book, identified by your user name, gives you access to its 
contents from any workstation on your network. The local address book is tied to the workstation 
that it was created on and is called local.    You may have been given access to other address 
books by your System Administrator or another individual. These will also appear in the window 
above.

To expand any address book, click the mouse arrow on the plus sign to the left of the address 
book name.    A double click on the icon will open the address book into its own window.. Once an 
address book has been expanded, all names and lists contained within that book will be shown. 
The lists appear first and may be expanded to show their contents.



Types of Addresses
Address books not only contain the names of individuals and their email addresses but may also 
group those individuals into lists so that they are easier to identify and send group email to.

For instance, if you often send mail to many individuals of a particular company, all those 
individuals can appear under the company listing. Names appearing in a list will also 
automatically appear in the general book.

You may also send email to individuals named within a list without sending to the entire list. In this
way, lists may be used as an organizational tool for your address book allowing you to group by 
company or organization.



Address Book View Options
Depending on how you organize your address books, you may elect to view only certain types of 
entries. The options available are People, Lists or Both and are available in the View menu. If 
you organize all entries in your address book into lists you may elect to view only Lists, whereas, 
if you only maintain lists for group mailings you may wish to view both Lists and People.



Adding a List to the Address Book
After accessing the address books by clicking 
on the Addr button on the toolbar you may 
add a list to an address book by first selecting
the appropriate book by clicking the mouse 
on that name. After the Address Book has 
been selected, click on the New List button on 
the toolbar or select List… under the 
File/New menu.

The following window will appear:

Figure 60 Create New List Window

To create a new list name in your address book, delete the current information, type in the 
required name with spaces and click on OK. This will add the new list to the selected address 
book enabling you to add individuals to the list.



Adding an Individual
After accessing the address books by clicking 
on the Addr button on the toolbar you may add 
a name to either a list or to the address book 
generally. To do this, select either the list or 
book by selecting the object then either 
clicking on the New button or selecting Person 
from the File/New menu.

The New Person Properties Window will appear and allow you to insert the name, alias, email 
address, phone number and address of the person to be added to the address book.

Figure 61 New Person Properties Window

After the correct information has been entered click on OK. Use the Cancel button if you wish to 
cancel the addition operation. Only the name and email address sections must be filled in. All 
other fields are for your information only. 



Adding Additional Information to an Address Book Entry
In addition to adding the name, alias, email address, phone number and address of an individual 
to the address book, you may also add additional information for each name in your address 
book. This information may be company names, titles or any other significant pieces of 
information.

Additional Information has two parts: the attribute name and its corresponding information. To add
additional information take the following steps:

1. Click on the New button;

2. Replace Attribute_1 in the first box with the attribute name of the additional information you 
wish to create.

3. In the next box place the required information.

For instance, to add an attribute name called "Company" with the company name The ESYS 
Corporation, the Properties Window would resemble the following:

Figure 62 Address Properties Window showing added Information

Save the information by clicking the Add button. You may add as many pieces of additional 
information as you want for any one individual by clicking on New. To access the information for 
review select the attribute from the drop down list. 

To delete or edit a specific piece of additional information select the attribute from the drop down 
list to place it in the Additional Information box. Click the Delete or Edit button depending on the 
action required.



Aliases
What is an alias? An alias is usually a word or name that you can remember easily.    The alias 
serves as a "short form" of an email address.    Expanding an alias into a full address is done by 
using Simeon Mail's expand feature while in a Compose window.    This will save you the time of 
looking each address up in your address book.    Expanding any number of aliases is possible 
and it can be done in any of the To:, Cc:, Bcc: or Reply To: fields.    

More:
Expanding Aliases
Automatic Expansion of Aliases



Expanding Aliases
An alias or multiple aliases may be expanded 
into any of the address fields by entering the 
alias(es) into the preferred address portion of 
the Compose Window, and then clicking on the
Expnd button. The result of this action will be 
the expansion of the alias(es) into a full email 
address(es).    The following steps explain the 
complete process for expanding aliases into a 
Compose Window.

1. Ensure that all books that you wish to search have the Search in Compose option selected.  
If you have not selected this option, it can be toggled in an Address Book Properties window. 
Properties windows are accessed by selecting the address book and clicking on the Info 
button or Properties from the File menu.

2. Enter an alias into the address field of a Compose window.    Remember you may enter more 
than one alias into any address field and that multiple entries must be separated by a comma.

3. Click on the Expnd button or select the Expand Aliases option under the Compose menu.

If the alias that you have entered and expanded matches more than one individual, Simeon Mail 
will ask you to select the correct address from a list of matches.

Figure 63 Expand Address 

Hint:    Addresses can be expanded against more than just the alias. Go to Tools/Options/Edit 
and click on Send to access Alias Expansion properties. Even if you have not selected "Auto 
Expand Aliases on send" expanding against the name, email address or alias is still available for 
manual expansion using the Expnd button.



Automatic Expansion of Aliases
Aliases can be automatically expanded on Send by selecting this option through Options/Edit 
menu and clicking on Send. For more information on how automatic expansion works please 
refer to Send Options. 



Adding a New Address Book
To further organize your address books you may wish to create additional books to be used for 
specific addresses. For instance, all email addresses of a personal nature may be stored in a 
separate address book on your local machine, thereby limiting access by other users.

To add a new address book select Address Book from 
the File/New menu or the new book button on the 
toolbar.. The following window will appear allowing you 
to input the information required to create the new book:

Figure 64 New Book Properties Window

A brief description of the available features that can be considered when you are creating a new 
book are below:

1. Book Name:    a title for the address book that will represent the contents. This name cannot 
contain any spaces or special characters (%$#@*).

2. Search in Compose:    if selected, it will allow this book to be searched each time you 
expand an alias.

3. Location:    you can choose to save the newly created book by selecting one of the two 
locations described below: 

a) Local Machine:    on your local hard drive (i.e. your PC).    Local Address Books 
cannot be shared and the icon is depicted over a disk.

b) Remote Server:    to a hard drive on your network.    Selecting this option will enable 
you to share the Address Book with other individuals on your network.

4. Search: If you are creating this Address Book to contain specific addresses that currently 
exist in other books you may wish to define a search rule. For more information on creating 
an advanced search for Address Books please refer to Address Book Advanced Searches.



More:
Search in Compose
Setting Access Permissions



Search in Compose
If you wish the new book to be searched when expanding aliases, select this box in any address 
book creation or properties window; if you are unsure, you can always choose to select or 
deselect it later in the Address Book Properties Window.



Setting Access Permissions
Clicking on the Sharing... button in the Properties window will open the Access Permissions 
window.    In this window, you can decide who has access to the address book and the level of 
their access.    Remember, any future additions or deletions to this book will be reflected to all 
sharing individuals, but if changes to individual permissions have been made at the same time, 
they are only for valid for the new additions.    The window will be similar to the Access 
Permissions window below:

Figure 65 Access Permissions Window

A brief description of each feature can be found below:

Add and Delete enables you to either enter or delete a new individual or group to the User/Group 
field.    To add an individual or group simply enter in the person's userid or the groupid into the 
field and select the permissions for that person. Remember that a person's userid is the name 
they are known by on the system the same way the user name is specified in an email address. 
To specify different permissions for individuals, either select these permissions when they are 
being added or select the individual and modify the permissions.    If you wish to share the 
address book with all individuals on your network, type in the group name anonymous and set the
appropriate permissions.

Read privilege enables an individual to access the book and read or paste any addresses(es) to 
the various fields of a Compose window.

Write privilege will allow the individual to access the address book and enter new addresses into 
the book or delete addresses in the book.

Admin (Administrative) privilege allows: reading, adding, deleting, and changing access 
privileges for any individuals to the address book.    You will automatically be given Administrative 
privileges to any address book that you have created. Other individuals, such as a Systems 
Administrator, may give you Administrative privileges to other address books.



Searching for an Address
If you cannot find an address or can't remember who you should email or what department to 
send certain information to, you can always search your address books for this information. Any 
field available in any of the address books available to you can be searched using either the quick
search or advanced search method.

More:
Quick Searches
Address Book Advanced Searches
Defining an Address Book Search Rule



Quick Searches
Once your address book window has been opened 
and the books you wish to search chosen, clicking 
on the Srch button on the toolbar or selecting 
Search from the File/New menu will access the 
quick search window.

Figure 66 Addressbook Quick Search Window

Quick searches can be made against all or any one of the name, alias or email address fields. As 
well, a search target can be a person or a list. 

To do a quick search:

1. click on the Srch icon in the toolbar to access the quick search window;

2. choose your target, either person or list;

3. select one or more fields to search in;

4. input the text to search for;

5. click OK. 

The results of your search will be displayed in an Addressbook Search window similar to the one 
shown below. To cancel the search before it is performed use the Cancel button.

Figure 67 Address Book Search Results

Note:    Address book searches are only kept for the current Simeon Mail session. If you wish to 
keep the search you should change the name from the default name assigned by Simeon to a 



name defined by you. Change the name by selecting the search and clicking the Info button or 
selecting Properties from the File menu.



Address Book Advanced Searches
Advanced searches allow for more in-depth information to be searched in your address books. 
Again, before beginning an advanced search the address books you wish to search must be 
chosen. After the address books to search have been chosen access the advanced search 
window by selecting Search from the File/New menu and clicking on Advanced.

Figure 68 Search Properties Window

The Search Properties window is the first step to defining a search rule for an address book 
advanced search. It allows you to name the search, choose additional address books to search 
in,    define the search and perform the "sanity check" by performing a pre-search count to 
determine the number of matching addresses.

Naming the search: Originally named as Search#, searches can have any name you choose.

Search books: You can add or delete books already in the list. As well, the Count Books button 
will count the number of books you have chosen for your search.

Search rules: The Search Rule area is the area that actually defines what you are looking for. In 
this section you can choose to search using one or more of the existing rules or use the Define 
Rule button to create new rules or modify existing ones.

Search count: If you want to test your search before actually grabbing the results the Count 
button will let you know how many addresses matched your criteria. Depending on the answer, 
you can then narrow or expand your search or click OK to collect the addresses.



Defining an Address Book Search Rule

Figure 69 Address Book Advanced Search



Target
The target is the object you are looking for. In the case of a advanced search in address books 
the object may be either a person or a list.



Rule Name
The name given to a specific search rule. On clicking the New button, the rule name will be set 
out as Rule#. You may rename the rule to better reflect the context of the search to be performed.



Search Phrase
The search phrase consists of an attribute and possibly criterion and one or more parameters. 
One or more search phrases comprise a search rule.



Attribute
Attributes consist of a predefined list of possible search areas that act as the basis for creating 
search phrases. Attributes may act with or without criterion.



Criterion
Criterion is a list of predefined standards that determine how an attribute is used. For example, an
attribute of "name" may have as one of its criterion "contains". All criterion require parameters, 
however, not all attributes require criterion.



Parameters
Parameters are the boundaries specified for qualifying an attribute and criterion. In address 
books, parameters are word strings that can be contained in the field, start or end the field or is 
the entire field.



Search Rule
The search rule box contains the list of search phrases that comprise the rule. Each phrase may 
be edited or removed from the search rule box or all phrases may be removed from the search 
rule box.



Modify
If a name has been specified in the Rule Name box then clicking on Modify will activate that rule 
allowing you to change any or all of its phrases.



New
Clicking on New allows you to create new rules for searching your address books.



Delete
The Delete button will delete the rule named in the Rule Name box.



Permanent and Temporary Address Book Searches
Initially all address book searches created are temporary. That is to say, upon exiting Simeon Mail
the search will be deleted. Temporary searches will be named Search#.

To make a search permanent:

1. select the search;

2. click on the Info button or choose Properties from the File menu;

3. in the name field select the existing name, Search#, and replace it with a new name.



Modifying the Address Book
To modify an entry in the address book, whether 
an individual, list or the book itself, first select 
that entry by clicking the mouse button on the 
name and clicking on the Info button or 
Properties from the File menu.

This will bring up the appropriate properties window related to the particular object selected.    The
separate properties windows offered are:

More:
Person Properties Window
List Properties Window
Book Properties Window



Person Properties Window
If an individual address has been selected a Person Properties window similar to the figure below
will be displayed: 

Figure 70 Person Properties Window

All information contained in the Properties window may be modified. You may also attach 
Additional Information to names already existing in the address book.    

Note:    You cannot use this feature to add new names to your Address Books as the current 
information will be substituted for the new.



List Properties Window
The List Properties window displays the current name of the list and the number of entries within 
the list.    Only the list name may be modified when in this properties window.    The number of 
individual members within the list will automatically change as individuals are added or deleted 
from the list.    Below is an example of a List Properties window:

Figure 71    List Properties Window



Book Properties Window
As in the Properties window below, you are provided with information on the name, ability to 
search, location, and number of entries of a selected book.    

Figure 72    Book Properties Window

Selecting Sharing... from this window, will allow you to modify which individuals have access to 
the your Address Book and the degree of their access.    In order to have access to sharing 
address books you must have specified that the address book will be stored in a remote location 
by clicking on the Remote Server radio button.    This must be done at the time the book was 
created since option cannot be changed at a later time. Remember that the Address Host must 
have been specified on starting Simeon Mail or under the Tools/Options/Edit menu in 
Addressbook Organizer. For more information on sharing address books please see Setting 
Access Permissions.

This window also indicates what advanced searches have been performed and gives you access 
to those searches by clicking on the Define… button. For more information on searching your 
Address Book please refer to Address Book Advanced Searches in the Address Book section.



Drag and Drop
It is possible to drag and drop an individual name or list to a specific list or from one address book
to another. When drag and drop is used in the address book the information is either copied or 
moved.

To move an address simply select the address and drag and drop it into the new address book or 
list. If you are moving it into a different address book the address will be removed from the 
original book.

If you are copying the address select and hold the mouse on the address and hold the CTRL key. 
Drag the address to the new book and release the mouse and the CTRL key. This will copy the 
address leaving the original address in the original address book.

Lists    that are dropped into other lists are independent of the original. That is, any changes made
to the original list will not be reflected in the list within a list.

Note:    You may select more than one address to move or copy by selecting the first address and
the SHIFT key for contiguous block of addresses or the CTRL key for non-contiguous addresses.



Converting an old Address Book
It is possible to convert existing address books from the style used in ECSMail 2.4 or Pine to that 
used in Simeon Version 4.0. To do this, take the following steps:

1. Open your Version 4.0 address book and select the address book that will receive the 
converted information. Do not expand the chosen address book.

2. From the Address menu select Import and navigate through your system to the location of 
your Version 2.4 address book.      The ECSMail or the Pine Address list will be called Ibook.

3. Select the book to be converted and click on OK. 

More:
Extended Importing of Address Books



Extended Importing of Address Books
Simeon Mail supports importing of all text files that are in a Key-value tab delimited format.    The 
key represents the related value (e.g. person's name) and the tab is one-standard tab.    In the 
case of the example below the tab will be represented by "<tab>" and the beginning of a new line 
is indicated by "<nl>".

Key-value tab delimited format: key=related value<tab>key=related 
value<tab>...

More:
Person Record
List Record



Person Record
The keys that are supported in the Simeon Mail address books are: Name, alias, email, phone, 
address and an "open-key "(undefined) for additional information.    Any combination of these keys
may be used to format a file and the keys can be used in any order.    Below is an example of two 
records to be imported into Simeon Mail's address book.    Each Person Record must be in a 
single line.

Name=Doe,John<tab>alias=Jon<tab>email=jdoe@company.com<tab>phone=(
403) 555 4545<tab>address=1234-56 Ave<tab>spousesname=Jane<nl>

Name=Smith,Jane<tab>email=jsmith@abc.com<tab>..<nl>

Note    Version 4.0.x format with the key "entryname" for importing both persons and lists is still 
supported.



List Record
Address lists can also be imported into Simeon Mail.    The keys that are supported are Name and
member and must be used in order. The entry names are contained within a bracket pair and 
commas present in an entry name must be replaced with a double comma, the list members may 
not contain a bracket.    For example:

Name=testlist<tab>member=(entry1,entry2,...)<nl>
Name=listname<tab>member=(Doe,,John,Smith,,<nl>
Jane,etc...)<nl>

 (Note: a single comma is used as an entry separator or delimiter)

When importing Key-value tab delimited format files ensure that all Person Records are contained
in a single line.    A correctly formatted file can contain both person and list records in any order, 
however only a List Record may contain new lines (see example above).    Your Systems 
Administrator will be able to assist you in the process if you have any difficulties.



Exporting Addresses
Choosing Export from the Address menu will take the contents of the Address Book chosen and
export it into a plain text file. The contents of this file can then be edited using a text editor such 
as Notepad. After the information has been edited you can then use Import from the Address 
menu to return the information to the Address Book. This feature is also useful when sharing 
address information with other mail users when access control is not an option.



Introduction
The Public Directory allows you to search for information regarding companies, departments, and
individuals within those companies in directories made public by other corporations and 
educational facilities. Think of it as an on-line telephone book.

These directories, sometimes called X.500 Directories,    might be prepared by a Systems 
Administrator at your site or through an agency who specializes in providing information for a 
specific industry, government agency or group of companies.    Public Directories may be stored 
locally on your network or accessed from a system outside your network.

This section is included for those sites who have purchased the Public Directory for Simeon Mail. 



Accessing the Public Directory
The Public Directory, shown below, is accessed through the Address menu by selecting Open 
Public Directory.    The Public Directory will initially open showing your site. After it has been 
opened you can search for the information required.

 

Figure 73 Directory Viewer

Note    If the Public Directory menu item is grayed please refer to Changing Address Book Host to
properly configure the X.500 host for the Public Directory.



Searching the Public Directory
Each search performed in the Public Directory starts with the search for a person. However, if you
are unsure of a name, first or last, a department or an organization, you may truncate the name to
browse all those entries that match the abbreviated information used. At a minimum the person 
and organization fields must be filled in.

Use the Srch button or select Search Public 
Directory from the Address menu to access the 
search screen for the Public Directory. An example 
of a search may resemble the following:

Figure 74 Person Search Example

More:
Search Results



Search Results
After the search has been completed the results of your search will appear in a window similar to 
the one shown below. 

Figure 75 Results of Person Search

This window supplies all the information available through the Public Directory for the person 
searched. It also allows you to paste the name and email address into either a Simeon Mail 
Compose Window or into the Simeon Mail address book.

The Directory Viewer window shows how the results of your search fit into the structure of the 
Public Directory and will allow you to browse through the Public Directory.

Figure 76 Directory Viewer

To paste the email address into the Compose 
Window click on the button displayed here.

To retain the name and email address in your 
Address Book, click on the Save button. 

The Directory Viewer will then display all address books to which you have write access allowing 
you to choose which address book will receive the new address information.



Figure 77 Addressbook Selection Window



Using the Directory Viewer
The Directory Viewer can be used for browsing and viewing entries in the Public Directory. The 
following will explain the buttons in the Directory Viewer and their functions.

The Browse button will expand the directory structure
to include any information contained within the 
highlighted selection. 

Generally, countries, organizations and departments will all contain additional entries and the 
names of those entries may be expanded, allowing you to refine your search or gather further 
information regarding the organization searched. To browse further listings regarding a specific 
entry, either double click on the entry or select the entry and click the Brows button.

The View button will view the information regarding 
the chosen entry contained in the Public Directory. 
The following is a sample of what information is 
available when you view the information contained 
regarding an organization.

Figure 78 View of Organization

Use the Prev and Next buttons move up and down 
the list in the Directory Viewer. When you get to 
the desired entry click on View or Browse to 
access the information you require.

Introduction
Folders are a specific location where messages physically reside. In that sense Simeon Mail folders are 
not much different than a folder found in a filing cabinet. For instance: 



· both store information;

· both can be further sectioned into sub-folders; 

· information can be copied so they reside in more than one folder; 

· folders can be re-filed or moved between filing cabinets; and

· folders can reside in many different filing cabinets.

So, for Simeon Mail, this means that folders can:

1. store messages;

2. support a folder hierarchy;

3. contain copies of messages that also reside in other folders;

4. be moved or copied to other folders or message services; and

5. reside in any message service created in Simeon Mail.

The major difference between Simeon Mail folders and filing cabinet folder is that Simeon Mail folders can
be searched using two methods. Firstly, one or more    for folders can be searched for messages that 
meet a certain search criteria. This criteria can be names, dates, subject matters or keywords. Secondly, 
each folder can have attached to it a search that only retrieves relevant messages. This is particularly 
useful for the inbox folder in that only new messages received on a daily basis need be accessed when 
logging into Simeon Mail.



Recommended Folders
In addition to the inbox folder, it is recommended that you create at least three additional folders to help 
manage your mail. These folders are:

1. drafts - used to store messages that are still unfinished and in draft form;

2. sentmail - used as the initial repository for messages that you wish to keep for reference but have 
been mailed;

3. outbox - used for messages that have been sent while you are working offline. Messages in this    will 
be sent when you reconnect to your network. 

See Also:
Compose Options
Send Options



Hierarchical Folders
The use of hierarchical folders is an extremely powerful way to control the storage of your 
messages. With hierarchical folders you can force messages that would normally go to the first 
available message group into a specific sub-folder. Think of it as manual control or messages as 
opposed to the automatic message sorting of message groups.

Note:    The PMDF server does not support hierarchical folders. All folders that cannot contain 
sub-folders will be indicated with a blue dot.

For example, in the Post Office message service you have a folder entitled "Budget".    Under 
Budget you have two additional folders, 1996 and 1997. In each of these folders you can place 
additional folders further defining how you want to organize your messages. Below is an example 
of how these folders might be organized.

Figure 79 Hierarchical Folders

Note:    When numerous sub-folders are present it can sometimes be confusing to look at folders,
sub-folders and Messages Groups. By selecting Hide Message Groups from the Folder menu 
you can turn off the display of message groups for a selected folder.



Controlling the Display of Folder Contents
Initially on opening a folder Simeon Mail will retrieve all the messages contained therein. In some 
cases, however, you may wish to retrieve only those messages that were received since you last 
accessed the folder or within a certain time frame. Simeon Mail allows you to do this without 
having to create a separate Search folder by using the Selected option in the folder properties or 
New Folder window. You can attach a search to any folder at any time.

Information on retrieving specific messages only within any folder can be found in Managing your 
Folders through Searching.

Note    If you clean deleted messages from any folder that has been filtered through a search, all 
deleted messages within that folder will be cleaned whether they have been retrieved or not.



Creating a New Folder
To create a new folder, first select either the message service that will contain the new folder or 
the folder that will contain the new sub-folder. After the folder location has been chosen select 
Folder... from the File/New menu. The following window will appear allowing you to name the 
new folder and set some attributes.

Figure 80 New Folder Window

Remember:    Due to restrictions in IMAP you may not create sub-folders in the inbox folder.

A description of the available features when creating a new folder are:

Name: To insert a folder name click the mouse in the folder box and remove the current value-
Untitled by typing or pressing the DELETE key. Type the one word name of the new folder.

Rule:      Folder names are one word made up of alpha or numeric characters only. They may 
contain an underscore ( _ ). Some servers do not accept special characters such as &, %, *, #, \, /
or periods. Please check with your System Administrator if you are using any of these characters.

Where: This is the name of the message service or folder that was selected for the new folder. 
Remember that the inbox folder cannot contain additional sub-folders.

View Message Groups: When dealing with hierarchical folders it is sometimes confusing to view 
both these types of folders and their respective message groups. If you have a folder that 
contains numerous hierarchical folders it may be easier not to view message groups. This feature
is set on a per folder basis.

Sort by:    Simeon has the ability to sort mail within folders.    The criteria for sorting mail is set by 
selecting one of the options available under "Sort by".    Simeon will use this feature only if you 
have not selected the View Message Groups option under the Folder menu. In this case the 
sort order assigned to the message groups will take priority. 

Search and Search Rules: Probably the most powerful feature associated with creating a folder 
is the ability to bring to that folder only pertinent messages. This is done using folder Searching. 

If you have Selected as your choice in the Search box, Search Rules will be active and allow you



to define a search. Please refer to Managing your Folders through Searching for more information
on searching in a folder.

Sharing: If you are using a Simeon IMAP 4 server the Sharing... button will be active and you can
set access permissions for specified individuals.    This feature will allow you to share folders with 
other individuals and specify the level of access to these folders.    For more information on 
Sharing please refer to Setting Access Permissions.

Finally, click on OK if you wish to add the folder or Cancel if you wish to cancel the operation.



Folder Properties
To get information on an existing folder, select the appropriate folder by clicking on it and either 
select Properties from the File menu or click the Info button on the toolbar. The following 
Properties Window will appear for the chosen folder:

Figure 81 Folder Properties Window

On requesting information for the inbox folder, you will notice that you cannot change the name of
the folder.    Since the inbox folder has been designated to receive all your new mail you may not 
change its name or unsubscribe from this folder.    You can fully manipulate all of the information 
in this window for any folder. For more information on the searching capabilities in folders please 
refer to Managing your Folders through Searching. 

You will also notice an additional button labeled Sharing....    If you are using a Simeon IMAP 4 
server the Sharing... button will not be grayed as it is in the above figure.    Sharing will allow you 
to set access permissions on your folders so that you may share the contents of these folders 
with other individuals.

More:
Setting Access Permissions
Changing the Folder Name



Setting Access Permissions
Clicking on the Sharing… button in the Properties window will open the Access Permissions 
window.    In this window, you can decide on who has access to the folder and the level of their 
access.    Remember, any future additions or deletions to this folder will be reflected to all sharing 
individuals, but if changes to individual permissions have been made at the same time, they are 
only for valid for the new additions.    The window will be similar to the Access Permissions 
window below:

Figure 82 Access Permissions Window

A brief description of each feature can be found below:

Add and Delete enables you to either enter or delete a new individual or group to the "User / 
Group" field. The name entered for a user will be their user name as they are known on your 
system.

Note:    If you add the name anybody to the User / Group field you will allow any user with access
to your server access to the folder you wish to share.

Read privilege enables an individual to access the book and read or paste any addresses(es) to 
the various fields of a Compose window.

Write privilege will allow the individual to access the folder. They will be able to create new 
message groups, delete message groups, copy or move messages in and out of that folder, mark
messages for deletion and clean deleted messages.

Admin (Administrative) privilege allows all the privileges associated with Write plus the ability to 
add, delete and change access privileges for any individual to the folder.    You may also create a 
hierarchical structure within that folder.

You will automatically be given Administrative privileges to any folder that you have created. 
Other individuals, such as a Systems Administrator, may give you Administrative privileges to 
other folder.

Post allows those named in the Access Permissions window to post mail to this folder. The email 
address is usually the folder name followed by your domain name. Please check with your 
System Administrator to ensure that any folder set with a Post permission has been set up to 
receive mail.





Changing the Folder Name
The folder properties window can be used to change the name of any folder you have created. 
You will not be able to change the name of the inbox folder. 

To change a folder name:    

1. Click on the folder whose name you wish to change.

2. Click on the Info button or select Properties from the File menu.

3. In the folder properties window, click in the name box, delete the current value, and type in 
the new folder name. 

4. To confirm the name change, click on OK. Use Cancel to cancel the change operation and 
close the window.    



Deleting a Folder
To delete an existing folder, select the appropriate folder to be deleted and go to the File menu 
and select Delete or the Del button on the toolbar to obtain the folder deletion window as shown 
below:

Figure 83 Folder Deletion Confirmation Window

At this point you may delete the folder by clicking the mouse on the Delete button or Cancel to 
cancel the deletion process. Deleting a folder will also delete all messages contained in that 
folder.



Folder Subscription
Simeon Mail enables you to decide which folders will be viewed in any message service.    The 
only folder that is exempt is the inbox; since it acts as a repository for all incoming mail and must 
always be present.    This feature is very helpful when viewing Newsgroups since there can be 
hundreds of folders that can be viewed.    

To view all folders in a message service, select the message service and choose Unsubscribed 
Folders from the View menu.    All subscribed and unsubscribed folders will then be visible in the 
message service.    Subscription or unsubscription to any folder is accomplished by clicking on the
folder and toggling between Unsubscribe and Subscribe in the Folder menu.

Generally, folders created by you in the Post Office message services will be regularly subscribed
to since they are there for a very specific purposes. The area where folder subscription becomes 
vital to your day-to-day work flow is with shared folders in the Post Office message service and 
News Stand folders.

Note    To better differentiate between subscribed and unsubscribed folders, you may select the 
font and font color and styles for all unsubscribed and subscribed folders. This is found in the 
Tools/Options/Edit menu and selecting Fonts.

More:
Subscribing to Shared Folders
News Stand Folder Subscription



Subscribing to Shared Folders
Shared folders in the Post Office message service will appear at the bottom of the folder list. 
Each folder is named after the user who granted you access permissions. Most likely this folder 
will contain sub-folders to which you may subscribe. A shared folder may resemble the following. 
Note that not all sub-folders need be subscribed.

    
Figure 84 Shared Folders with Unsubscribed Folders in green text

To subscribe to a shared folder select the folder name and Subscribe from the Folder menu.



News Stand Folder Subscription
News Stand folders are set up to receive the various Usenet newsgroups. Remember, each 
folder represents a particular newsgroup and since there are literally thousands of newsgroups, 
folder subscription becomes imperative.

For more information on how to retrieve only those newsgroups of interest and, consequently, 
their respective folders, please refer to Subscribing to a Newsgroup.



Unwriteable Folders
You may occasionally come across a folder with a blue dot. This blue dot indicates that the folder 
is the last folder for which you will have access in the hierarchy. It does not indicate the type of 
access to have to the contents since, depending on the permissions given, you may have write 
permissions to that folder.

Generally, folders with the blue dot will be shared folders for which the owner has given you 
access and News Stand folders.

Note    Some servers do not support hierarchical folders. In this case all your folders will have 
blue dots.



Loosing a Folder Connection to your Server
In the event you loose a connection to any of the 
folders in a remote message service the icon 
associated with that folder will have a red circle over 
it. To regain a connection simply close and re-open 
the folder through the File menu.

Checking and Cleaning Your Folder
There are various ways to manipulate the contents of a folder. The following explains cleaning 
and checking new mail, both available through the Folder menu:

1. Clean removes all deleted messages from a selected folder.

2. Check New Mail will manually check for new mail that is periodically received through 
Simeon Mail.    Simeon Mail is pre-set to check for new mail every ten minutes, this default 
can be changed in Tools/Options/Edit under the Message Organizer option.



Introduction
Message groups are a powerful filter that are used to group email messages received in the inbox
or stored in any other folder, sub-folder or search folder into specific areas. 

A message group contains specifications about the type of mail it will receive. For instance, all 
mail from a specific source may route to one message group while all mail containing a specific 
phrase in the subject may route to another message group. These hooks are specified when 
creating the message group.

The classification of message groups will enable you to better organize the priority and subject 
matter of all messages received.



Creating a Message Group
In order to create a message group within a folder, the folder must be opened. After the folder has
been selected, go to the File/New menu and select Message Group. The following window will 
appear on your screen:

Figure 85 Message Group Creation Window

You are now able to name the new message group, choose to hide the group when it is empty, 
and select the criteria that will determine what mail will be routed to the new group.    There are 
three selections to make to determine the routing of mail:

1. The Message Field box contains a list of the fields that can be looked at to determine the 
routing of a particular piece of mail. Users may select the To, From, Subject, Cc, Bcc, Return 
Path, Reply-To or In-Reply-To fields for the pattern match. An additional field called Recipient 
is also available. This field combines the To, Cc and Bcc fields. You may also choose All 
which will look at all fields mentioned above for the match.

2. The Criterion box allows you to select the pattern-match criterion. This would be either 
Contains, Starts With, Ends With or Is.

3. The Pattern to Match box contains the actual pattern that will be looked at in the specified 
Message Field. Patterns are not case sensitive.

Note:    Prior to creating a new group, ensure that you have selected View Message Groups from 
the Folder menu. If you have not selected this option, none of your new or old message groups 
will appear in a folder.

For example, if you want to route all mail pertaining to Simeon into the Simeon message group 
you would select:

· Message Field to Subject.

· Criterion box set to Contains.

· The Pattern to Match would be Simeon.    

Remember that pattern matches are not case sensitive and, when dealing with subjective 
material such as the "subject" field, should be very general in nature, not be thought of as all 
inclusive. You are at the mercy of the message senders as to how they fill out the envelope 
section of their messages.

The Sort by box allows you to determine the order mail is sorted in any message group. Sorting 
may be done by arrival time, arrival date, sender or subject.



Choosing Hide if empty can be very useful if you have a large number of message groups.    
Also, since message groups have a specified criteria, their appearance will notify you of the 
arrival of specified mail groups.    To view any groups that are hidden, select Hidden Message 
Groups under the View menu.

Select OK  to confirm adding the message group or Cancel to cancel the addition operation.



Reordering Message Groups
Another factor which influences the routing of mail is the order in which you create your message 
groups.    Since pattern matches are very general and should not be thought to be all-inclusive, 
you may receive a message that will match more than one group.    For example, a subject line 
may contain criteria specified in more than one group.    Simeon solves this problem by placing 
the message into the group which occurs first in your list of message groups.    

It is not necessary to recreate all of your message groups if you want to reorder the routing of 
mail into groups.    To reorganize the order of your message groups, use the following steps:

1. Click on the group you want to move.

2. Holding the mouse button, drag and drop the group into the preferred position of the group 
hierarchy.



Message Group Properties
To obtain the information on any message group such as the criteria for routing the mail, select 
the appropriate message group and either click on the Info button or select Properties from the 
File menu. A window similar to the following will appear on your screen:

Figure 86 Message Group Properties Window



Changing Message Group Criteria
After bringing up the properties window for any message group by selecting Properties from the 
File menu or clicking on the Info button, any of the options may be changed. If you change any of
the options for a message group, Simeon Mail will reorganize your folder to conform to the new 
options. Any messages that no longer belong in the changed message group will be transferred 
to the next message group that fits the criteria or the Main message group.



Hidden Message Groups
You may choose to hide your message groups when they are empty by clicking on the Hide if 
empty box found in the message group properties window. This feature is very helpful for 
focusing in on groups that contain mail.    If you would like to view a message group that is hidden
or change the sorting criteria of a hidden group, select Hidden Message Groups under the View 
menu.    

To hide all the message groups, select Hide Message Groups under the Folder menu. 



Deleting a Message Group
To delete a specific message group, first select the required group from the message services 
window and Delete from the File menu or the Del button on the toolbar. You will be prompted as 
to whether the messages in the group or the group itself to be deleted and you will have the 
option to cancel the operation. If you delete only the message group, the messages in that group 
will be reallocated to the next appropriate message group or groups.

Figure 87 Message Group Delete Options



Introduction
This section further explains the function of message services and how to create them.    
message services act as a receiving house for all mail received by a particular user.    There are 
two types of    message services:    Mail and Bulletin Board.    Mail message services receive mail 
that has been addressed specifically to a user.    Bulletin Boards are shared message areas 
where people can retrieve and respond to messages.    An example would be mail received over 
Internet from the various newsgroups to which you may subscribe.



Existing Message Services
Simeon Mail has three system-created message services: Post Office, News Stand and Local 
Folders.    The Post Office is where general mail is received for each user; News Stand will 
contain mail received from the various newsgroups to which you may belong; and Local Folders 
allows you to store folders, message groups and messages locally on your computer.



Naming a New Message Service
You may wish, however, to set up a new message service that will act as the receiving house for 
all messages received by another individual. If a colleague goes on vacation, they may want you 
to monitor their incoming messages. An assistant may also have access to their supervisor's 
message service in order to respond to email requests.

Message service names should represent the contents. If you are monitoring another user's 
messages, you may elect to call the new message service by their full name, logon ID or just their
initials. Message service names may contain letters, numbers and spaces. Since access to a 
message service requires a user name and password, you will need the other user's login name 
and password to gain entry.



Creating a New Message Service
To create a new message service, click on the File menu and select New Message Service. The
following window will appear:

Figure 88 Message Service Creation Window

Initially New Service will appear in the first box of the creation window. To change this to the 
desired name, click the mouse in that box, delete the current value and type in the new name. 
Except for the Userid of the person whose mail will be monitored, the other information in this 
creation window will not require any changes as your Systems Administrator will have set up the 
default parameters upon installation of Simeon Mail.    

New message services automatically contain an inbox folder.    However, if a message service 
has been set up to monitor another user's messages, it will contain all the folders designed by 
that user.    The user-specific message groups for those folders will not be available; only the Mail 
and Deleted message groups as set up by Simeon Mail will be available.    Consequently, you 
may organize the message groups in each folder according to your needs.

Note:    If you are setting up a message service to monitor another person's mail, you should not 
check the box "use login for session default" when you initially log on to Simeon Mail.



Folder Prefix and Location
Folder prefix and location fields are designed to facilitate accessing multiple folder locations while
in the same message service.    Through the specification of different folder locations and prefixes
you can modify the contents of the selected message service.    For example, if an individual is on
holidays you can take care of their incoming mail by specifying their folder location and prefix and
then logging on with their userid and password.    The following section describes how to use 
these fields and contains some examples.

The folder prefix lets Simeon Mail know what to filter out when displaying the folders contained 
within that message service. For instance, a folder prefix of ~/Mail/ will filter out that prefix so your
message service has a cleaner look.

Figure 89 Filtered and Unfiltered Folder Prefixes

The format of the Folder Prefix represents the type of IMAP used by the server. Only one folder 
prefix can be listed for each message service that you have created. 

Folder Locations specify the actual location of those folders you wish to view. Multiple locations 
may be specified by separating each location by a comma or a semi-colon.

More:
Standard IMAP Entries
Local Message Services



Standard IMAP Entries
There are four main IMAP servers that will determine what the folder prefix and location will be in 
your message service. These entries are the standard entries for the type of IMAP server 
specified but should be considered a guide only. Please check with your System Administrator to 
ensure that they are correct for your site.

IMAP Server Folder Prefix Folder 
Location

Simeon IMAP2bis ~/Mail ~/Mail

Simeon IMAP2bis (blackbox) ~/ ~/

Simeon IMAP4 (or Cyrus 
server)

INBOX. INBOX.,user.

PMDF IMAP4 INBOX. INBOX.,user.

Local Message Services
For a Local Folders message service (a message service stored directly on your computer) the 
folder prefix and location will always be the same. The default location for the Local Folders 
message service is ~/. This will place the message service in the Simeon working directory on 
your hard drive.

You may choose, however, to have local message services in another location. In this case both 
the folder prefix and location will contain the full pathname to this message service (i.e. C:\work\
mail\ms1\).

Note    In all cases, when stating the location of a local message service the path must end with a 
"\".



Message Services Information

Figure 90 Message Service Properties Window



Name
The name your would like to call this Message Service. The name may be anything that will 
supply enough information for you to understand the nature of the Message Service.



Service Type
The type of service that this Message Service will be providing. The options are Internet (IMAP) 
Folders, Internet (IMAP) News and Local (File) Folders.



Folder Prefix
There are four main IMAP servers that will determine what the folder prefix and location will be in 
your Message Service. These entries are the standard entries for the type of IMAP server 
specified but should be considered a guide only. Please check with your System Administrator to 
ensure that they are correct for your site. In the case of the News Stand Message Service, this 
area will be blank.



Folder Location
There are four main IMAP servers that will determine what the folder prefix and location will be in 
your Message Service. These entries are the standard entries for the type of IMAP server 
specified but should be considered a guide only. Please check with your System Administrator to 
ensure that they are correct for your site. For the News Stand Message Service this area will 
contain a comma-separated list of the newsgroups that wish to access.



Host
The name of the mailhost from which you will be getting your mail.



Userid
The logon id of the user who will be accessing this Message Service. Unless you will be 
accessing someone else's mail from this Message Service this value will be your logon id.



Port
The port number of the mailhost, usually 143. 



Changing Message Services Information
When you have accessed the message service properties window, either by clicking on Info in the
toolbar or selecting Properties from the File menu, you may change any information contained 
in the message service properties window. Clicking on OK will accept any of the changes that 
have been made to the message service.    Simeon will ask if you wish to re-open the message 
service to take advantage of these changes immediately.    Click on Re-open if you wish an 
immediate change or click on Cancel to use the changes when you next log in.



Deleting a Message Service
To delete a message service, choose the appropriate service by clicking on the service's name 
and then go to the File menu and select Delete or click the Del button on the toolbar. Simeon 
Mail will confirm that you wish to delete the message service. At this point you may delete the 
service or cancel the deletion process.



News Stand
The News Stand message service is a bulletin board service that receives mail posted to the 
various newsgroups on Usenet. Usenet is a way for people around the world to exchange 
articles, opinions and ideas with others subscribing to a specific newsgroup. There are literally 
thousands of newsgroups covering topics as diverse as: computers, computer programs and 
programming, space, math and sciences, religion, sports and recreation. 

This chapter walks you through subscribing to some of these newsgroups and provides first-time 
users some tips on etiquette on the net (sometimes referred to as "netiquette"). We'll even teach 
you some of the lingo surrounding this sub-culture.

Not every site has Usenet set up in the same manner. This chapter is intended as a guide only. If 
you encounter any difficulties, please consult your Systems Administrator for clarification.

Setting up and playing with the Usenet is not a five minute job. Take your time, relax, enjoy the 
experience, have a coffee (better yet, find a newsgroup that talks about coffee--there probably is 
one).

More:
How to Decode Newsgroup Names
Subscribing to a Newsgroup
Newsgroup Folders
Usenet Lingo
How to Post
Posting vs. Mailing
Okay, So You Really Want to Post



How to Decode Newsgroup Names
Before subscribing to a newsgroup, it is beneficial to have some idea of what the newsgroup is 
about. Newsgroup names are short, either two or three words separated by periods which 
hopefully describe the nature of the newsgroup. Some newsgroups may have as many as four or 
more words.

The first word in a newsgroup name stands for the area of interest. For instance, all newsgroups 
beginning with comp deal with computers while sci is science, rec is recreation and soc is 
social.

The second word in a newsgroup name is the specific subject matter. Computers is a very 
diverse topic, so it has been broken down into subgroups such as unix which deals with specific
UNIX issues, pc which contains discussions, on personal computers or mac for Macintosh to 
name just three.

There is often a further breakdown in newsgroup names. If a newsgroup becomes particularly 
popular with thousands of questions and discussions there might also be a further breakdown into
questions or d for discussion.

Here are a few examples on decoding a newsgroup name:

comp.sys.mac.hardware: This one deals with Macintosh hardware in the computer systems 
newsgroup.

comp.sys.ibmpc.games: So, what games are available for your IBM PC? Again, it is in the 
computer systems newsgroup.

There is a specific newsgroup to which all new users should subscribe. That is 
news.newusers.questions. As you can see, this group deals with questions asked by new 
users of Usenet. It is the place where new users can find answers to frequently asked questions 
and also post their own questions.



Subscribing to a Newsgroup
As mentioned, there are hundreds of different newsgroups with topics that appeal to a wide-
ranging audience. The hard part about subscribing to any of these newsgroups is to pick the ones
that interest you most. It is suggested that new users subscribe to 
news.newusers.questions. That is where we will begin.

More:
Choosing Your Newsgroups



Choosing Your Newsgroups
When first opening the News Stand message service, all potential newsgroups will be displayed. 
Each of these newsgroups will be displayed as a folder. There are literally hundreds of 
newsgroups, so this list will be long. 

To shorten this list you may use the message service properties window to list the newsgroup 
prefixes of those newsgroups you wish to access. To access this box select the News Stand 
message service and click on the Info button or Properties from the File menu. This will display 
the following window, allowing you to specify the location of those newsgroups you wish to view.

Figure 91 News Stand Properties Window

The newsgroup prefixes go into the folder location area. If more than one is used they may be 
separated by either a colon, semi-colon or comma. When you have listed the locations you wish 
to view, click on OK. Simeon will ask if you wish to re-open your message service in order to take 
advantage of the changes immediately. If you wish to re-open, click on the Re-open button. If you 
do not have a number of newsgroups listed belonging to the prefixes requested, check 
Unsubscribed Folders in the View menu ensuring that all unsubscribed newsgroups will be 
listed.

Once you have all of the newsgroups listed you can pick and choose. Since each newsgroup is a 
Simeon Mail folder, subscribing and unsubscribing to newsgroups is done in the same way as 
subscribing and unsubscribing to folders in your Post Office by choosing Subscribe from the 
Folder menu.

The newsgroup folders are listed in alphabetical order. To go to news.newusers.questions 
scroll down the list until you reach the newsgroup. If it is unsubscribed select it and select 
Subscribe from the Folder menu.

Subscribe to as many newsgroups as you like. You can always unsubscribe later if you find you 
have no interest in the group. Keep in mind though, the more newsgroups you subscribe to the 
more you will have to scroll through to get to the newsgroup you want to read at any given time 
(especially if you find you are not reading most of the newsgroups).



Newsgroup Folders
As with Post Office folders, the News Stand folders also    have Main and Deleted message 
groups. If these are your only two message groups then all messages received by that 
newsgroup will be directed to the Main message group. All messages that you have read and 
deleted will go into the Deleted message group. 

You may want to set up other message groups that will direct specific messages in the 
newsgroup. For instance, in rec.food.recipes there are very specific rules for the Subject 
heading. If you choose to classify the recipes received into meat, chicken, vegetable and such 
you could set up message groups that would route those specific recipes to the appropriate 
Group.

For more information on setting up message groups please refer to the section on message 
groups.



Usenet Lingo
If you're gonna play with the big boys, ya gotta talk like 'em. While news.newusers is the place 
for new users not to feel intimidated, you can't stay there forever. When you are reviewing mail in 
any particular group there are various shortforms and buzz words used by experienced users. 
These shortforms are used for a purpose--it costs money, time, resources and effort to post to a 
newsgroup, shortforms save all of these.

:-) This is a smiley face, indicating the author is making a joke. Consequently :-( would be 
a sad face.    Even ;-) if you want to wink at someone.

BTW By The Way

FAQ Frequently Asked Questions. Most newsgroups will periodically post a FAQ list. These 
lists can be very helpful to new users (or new subscribers to a newsgroup).

FYI For Your Information

IMHO In My Humble Opinion or In My Honest Opinion

RTFM Read the F*ing Manual. Sometimes your questions are answered in the manual (it has 
been known to happen, honest!).

WRT With Respect To



How to Post
Posting to a group is not unlike mailing to an individual.    The difference is in the address entered 
into the To: field.    It is only necessary to enter the domain name of an address; for example, a 
personal address would be user@domain.name while newsgroup you would be only 
domain.name.    Three examples of newsgroup addresses are:    news.newuser;    rec.humor;   
comp.mail.misc .



Posting vs. Mailing
Yes, there is a difference. You post to a newsgroup you mail to an individual subscriber of a 
newsgroup. When you post, your message will be read by literally millions of people. The general 
rule is any personal message to be sent to another subscriber of a newsgroup, congratulations or
thanks or anything directed to an individual, should be emailed to that individual (their email 
address will appear either as a signature to the message or in the header). Posting is for 
questions or discussions. Think twice about posting questions about the group itself. Many 
newsgroups have a FAQ list that is posted periodically to deal with these day-to-day queries. 
Check this out first.

Rule of thumb for new users -- DON'T POST! Get the feel of a newsgroup first, check the FAQ, 
the manual, anything before posting. If you absolutely must post, please feel free to bother an 
experienced user for information on how to carry out a successful posting without annoying other 
users.



Okay, So You Really Want to Post
When you ask that experienced user for help on your first posting, you do not want to come 
across like you do not know what you are doing. Here are a few guidelines on how to prepare the 
message.

1. Before you begin, read the FAQ or other information file regarding the way articles should be 
posted to the newsgroup. For instance, some newsgroups have very specific ways of setting 
up a subject matter.

2. Keep your lines under 79 characters (even under 65 if possible). That way, if others include 
your message in a reply, the lines will not wrap.

3. Do not right justify your message text. It looks pretty but not all computers are created equal.

4. Most special control characters will not work for most readers. In fact, the space character is 
about the only one you can be sure will work consistently. Tabs should also be avoided since 
they are not the same from system to system.

5. Pictures and diagrams should not use embedded tabs.

6. Refer to articles by their Message-ID, never by the article number. Article numbers vary from 
system to system, Message-IDs are constants.

7. Articles written in a single case (either upper or lower) are difficult to read. As well, if you write
an article in upper case only, you will be considered to be YELLING at the recipient.

8. What you think is the previous article is unlikely to be so elsewhere.

9. Some newsgroups are moderated. This means that you cannot post directly to that 
newsgroup but must mail to a specified moderator who will look over your message and 
ensure it is appropriate and in the correct format. Moderating a newsgroup is not an easy 
task. Make sure you know the rules of posting to make the moderator's job easier.

Last but not least, should this be posted or mailed? Only you and your expert know for sure.



Shortcut Keys

Menu Item Shortcut
File/New/Message CTRL N
File/New/Quick Search CTRL + SHIFT S
File/New/Phone Message CTRL T
File/Open CTRL O
File/Close CTRL W
File/Properties CTRL I
File/Print CTRL P
File/Exit CTRL Q
Edit/Cut CTRL X
Edit/Copy CTRL C
Edit/Paste CTRL V
Edit/Delete DEL
Edit/Select All CTRL A
Edit/Find CTRL F
Edit/Find Next CTRL G
Edit/Replace CTRL H
Compose/Send CTRL S
Compose/Expand Aliases CTRL E
Message/Show Next CTRL + >
Message/Show Prev CTRL + <
Message/Reply CTRL R
Message/Forward CTRL + SHIFT F
Message/Delete CTRL D
Message/Undelete CTRL U
Message/Move to Folder CTRL M
Folder/Clean CTRL K
Folder/Check New Mail CTRL J
Address/Open Address Book CTRL B
Address/Capture Address CTRL Y
Tools/Spell Check CTRL L



Navigators
The following keyboard actions are designed to navigate and manipulate Simeon Mail without 
using the mouse. These navigation keys work in both the Message Organizer and the 
Addressbook Organizer. The table below is divided into three sections: key (keyboard key used to
carry out action), action (result of key use), equivalent (mouse equivalent—if applicable).

Key* Action Equivalent

RETURN/
ENTER

open, view double click

+ expand object click on + sign

- collapse object click on - sign

ARROW UP Select immediately 
preceding object.

SHIFT/ARROW 
UP

Add previous object to 
current selection.

SHIFT mouse select to 
select additional objects.

ARROW DOWN Select next object.

SHIFT/ARROW 
DOWN

Add next object to current 
selection.

SHIFT mouse select to 
select additional objects.

ARROW LEFT Expanded objects will 
collapse and remain 
selected. Focus will go to 
the parent object on 
collapsed objects.

Click on + sign when 
expanded object has 
focus. Click on parent of 
currently selected object.

SHIFT/ARROW 
LEFT

Expanded objects will 
collapse and remain 
selected. If object is 
collapsed all objects to and
including the parent will be 
selected. 

Click on - sign when 
expanded object has 
focus. CTRL click on parent 
when initial object has 
focus to select group.

ARROW RIGHT Collapsed objects will 
expand and remain 
selected. When object is 
expanded moves to the 
first visible child.

Click on + sign when 
collapsed object has focus.

SHIFT/ARROW 
RIGHT

On expanded object with 
focus will select parent and
first child in list.

PAGE UP Selects the object at the 
top of the screen or moves 
up one screen. 

Using vertical scroll bar.



SHIFT/PAGE UP Selects range from current 
focus object to top of 
screen.

PAGE DOWN Selects the object at the 
bottom of the screen or 
moves down one screen

SHIFT/PAGE 
DOWN

Selects range of objects 
from current focus to 
bottom on screen.

CTRL/HOME Selects the first object in 
the organizer. Will scroll if 
necessary. 

SHIFT/CTRL/ 
HOME

Selects all objects from the
current focus to the top of 
the organizer. Will scroll if 
necessary.

HOME Selects the first object on 
the screen.

SHIFT/HOME Selects all objects from the
current focus to the top of 
the screen.

CTRL/END Selects the last object in 
the organizer.

SHIFT/CTRL/ 
END

Selects all objects from the
current focus to the bottom 
of the organizer

END Selects the last object on 
the screen

SHIFT/END Selects all objects from the
current focus to the last 
object on the screen.

DEL Deletes the selected 
object.

Acts like the DEL button on
the toolbar.

Any alpha 
character

When a folder is selected 
will search for a folder 
beginning with that 
character. Works the same 
in the Addressbook 
Organizer when an 
address book is selected. 
Is case sensitive.

Note    If no object has been selected the navigator keys will first select the first object in the 



organizer. After an object has been selected it will perform the stated action.



Communication Protocol
Communication between computers on different platforms is essential for effective 
communication.    The Internet protocol (standard) used to transfer mail is Simple Mail Transfer 
Protocol (SMTP).    SMTP is limited to the US-ASCII character set (e.g.    plain-text produced in 
Notepad). This creates a problem when attaching non-ASCII based files.    Attachments like 
graphic images, video, audio, or some European languages require special coding to maintain 
the integrity of the file.    Multipurpose Internet Mail Extensions (MIME) provide Simeon with the 
information required to view and attach these unique files.

Note    MIME will not convert data from one application for viewing in another. As an example, it 
will not convert spreadsheets created in one application (eg: Lotus 123) to be viewed using 
another application unless the viewing application has that capability.

The form of the attachments are MIME content types and subtypes. The type declares the 
general format of the data and the subtype specifies the specific format of the data within a file.    
Simeon comes with a number of MIME-defined "attachment Helper Applications", allowing 
Simeon Mail to recognize the originator (e.g. application used to make the file) of a file and thus 
open the file.    However, new file formats are continually being developed and require that 
matching Helper Applications are defined.

Below is a selection of content types and subtypes that have been found to be useful. If you have 
access to the World Wide Web you may also wish to access 
ftp://ftp.isi.edu/in-notes/iana/assignments/media-types/media-types/

More:
Type Subtype



Type Subtype
text plain

richtext
application msword

postscript
rtf
wordperfect5.1
zip

image jpeg
gif
tiff

audio basic
video mpeg

quicktime



Folder Search Attributes
The following describes the different search attributes, their criterion and, if necessary, 
parameters to assist you in creating advanced searches in the Message Organizer. Remember 
that any number of attributes can be combined to make your search as general or specific as 
necessary.

Attribute 
Name

Attribute Definition Criterion Parameters

Body Will search the body for 
keyword(s)

contains/doesn't
contain

text string

CC Will search the cc field for
email address or name.

contains/doesn't
contain

text string

Comments Will search the comments
field for the test string

contains/doesn't
contain

text string

Date Received Will search the date 
received field for 
specified date.

before/on/since MM/DD/YY

Date Sent Will search the date sent 
field for specified date.

before/on/since MM/DD/YY

Date String Will search the body of 
the message for a date in
the format input.

contains/doesn't
contain

Date string in 
any format.

Deleted Will search only the 
messages marked as 
deleted.

n/a n/a

Not Deleted Will search only the 
messages marked not 
deleted.

n/a n/a

Draft Searches only for 
messages marked as a 
draft.

n/a n/a

Not Draft Will look only at 
messages that are 
marked as not draft.

n/a n/a

Encrypted Looks in the Encrypted 
header field for the 
keyword. The keyword 
being the type of 
encryption used in the 
message.

contains/doesn't
contain

text string

From Will search the from field contains/doesn't text string



for the email address or 
name specified.

contain

Header Will search for the 
specified header field and
keyword.

Name:
Value:

field name
text string

Header or Body Will search the any 
header field or the body 
of any qualifying 
message for the 
keyword(s)

contains/doesn't
contain

text string

In Reply To Will search the in-reply-to
field of the message 
header for the message 
ID or other information 
found therein.

contains/doesn't
contain

text string

Keyword This header field 
contains keywords or 
phrases, separated by 
commas.

has/doesn't text string

Marked Special Will look only for 
messages marked 
special

n/a n/a

Not Marked 
Special

Will look only for 
messages that are not 
marked special

n/a n/a

Message ID Will look in the header for
the specified message ID 
number.

contains/doesn't
contain

text string

New Messages are considered
new if they have been 
received since you last 
accessed your mail..

n/a n/a

Old Messages are considered
old if they were received, 
viewed or accessed prior 
to the last time you 
logged into your mail. 

n/a n/a

Priority Looks at the priority of the
mail received. Keyword 
can be high, normal or 
low.

contains/doesn't
contain

text string

Read Will look for only those 
messages that have been
read.

n/a n/a



Unread Will look only at those 
messages that are 
unread.

n/a n/a

Recent Recent pertains to those 
messages that have been
added to the inbox since 
the previous time it was 
accessed.

n/a n/a

References The contents of this field 
identifies other 
correspondence which    
this message references 
usually by message ID.    

contains/doesn't
contain/is

n/a

Replied To Looks only in messages 
that have been replied to.

n/a n/a

Not Replied To Looks only at messages 
that have no been replied
to.

n/a n/a

Size Will look at messages 
that are of a certain size. 
Size is a number 
measured in bytes.

is larger than/is 
not larger than/is
smaller than/is 
not smaller than;
is in range

value:

min:            max:

Sender Looks in the sender field 
of the message header 
for the match.

contains/doesn't
contain

text string

Subject Looks in the subject field 
of the message header 
for the keyword match.

contains/doesn't
contain

text string

To Looks in the to field of the
message header for the 
keyword match.

contains/doesn't
contain

text string

Addressbook Organizer Search Attributes
The attributes associated with the Addressbook Organizer are divided into two targets: person 
and list.

Target:    Person

Attribute 
Name

Attribute Definition Criterion Parameters

Address Looks in the address field contains/starts text string



for the keyword match with/ends with/is

Alias Looks in the alias field for 
the keyword match

contains/starts 
with/ends with/is

text string

Email Looks in the email field for
the keyword match

contains/starts 
with/ends with/is

text string

Name Looks in the name field 
for the keyword match

contains/starts 
with/ends with/is

text string

Other Looks in the additional 
information field (both 
name and value) for the 
keyword match

contains/starts 
with/ends with/is

keyword 
required for 
name and value 
fields

Phone Number Looks in the phone field 
for the keyword match

contains/starts 
with/ends with/is

text string

Target:    List

Attribute 
Name

Attribute Definition Criterion Parameters

Member Looks for the keyword as 
a member of a lists. 
Returns list and all 
entries.

contains/starts 
with/ends with/is

text string

Name Looks for the list name. 
Returns list and all 
entries.

contains/starts 
with/ends with/is

text string 

Glossary of Terms
Address Book
Advanced Search
Alias
Alias Expansion
ASCII
Attachments Box
Blind Carbon Copy (Bcc)
Bulletin Board
Carbon Copy (Cc)
Child Object



Compose Window
Configuration Options 
Configuration Specifications
Drag and Drop
Electronic Mail (email)
Electronic Mail Address (Email Address)
Folders
Helper Applications
IMAP
Mail Host
Message Groups
Message Headers
Message Service
Multipart Message
News Stand
Newsgroups
Objects
Offline
Online
Outbox
Parent Object
PGP
Properties Window
Quick Search
Session Manager
Subject
URL
Usenet
Viewer Window



Address Book
Address Books contain a list of people to whom you may wish to send mail. There are local and remote 
Address Books. The local Address Book is unique to you and resident on your computer. You may add, 
change, delete and organize it as you see fit. The remote Address Book, again, is yours but is maintained 
on a remote system on the network and is available to you from any workstation. Address Books support 
drag & drop and can be shared between individuals of the same usergroup.



Advanced Search
The advanced search is a more in-depth search than the quick search. Advanced searches allow for any 
number of keywords, statuses and time frames to be searched. Advances searches are available in the 
Message Organizer and the Addressbook Organizer.



Alias
Normally an attribute or short-form name given to an individual that is easily remembered.



Alias Expansion
The ability to type in a given attribute and expand it into the full body of information on a person.    Simeon
will expand an alias into the person's full email address.



ASCII
American Standard Code for Information Interchange (ASCII) files    contain only letters, numbers and 
punctuation.



Attachments Box
A part of the Viewer window, the Attachments Box contains the icons that represent any attachments that 
have been included in a message.



Blind Carbon Copy (Bcc)
Selecting Bcc when sending, forwarding or replying to a message will forward a copy of your message to 
the person indicated in the Bcc field without any other recipient of the message being aware of it.



Bulletin Board
Bulletin Board is a shared message area where people can retrieve and respond to messages, usually 
through Usenet.



Carbon Copy (Cc)
Entering an email address in the Cc field when sending, forwarding or replying to a message, will forward 
a copy of your message to the person indicated in the Cc field. All other recipients of the message will be 
aware of those receiving a carbon copy.



Child Object
Any object that is contained within another object is considered a child object. For instance, a folder is 
considered a child of the message service in which is resides. Sub-folders are considered the child of the 
folder that contains them.



Compose Window
The Compose window appears on your workstation when the Comp button from the toolbar has been 
selected. The Compose window consists of two sections: the envelope section and the message text 
section. The envelope section consists of the electronic mail address of the recipients of the message 
(original recipient as well as Cc and Bcc recipients) and a subject line. The message text section allows 
you to input the text of a message. If an attachment has been selected to go with the message an 
Attachment Box will also appear at the bottom of the Compose window.



Configuration Options 
Configuration options is the set of user options as defined under Tools/Options/Edit. These options 
provide individual users with a personalized workspace.



Configuration Specifications
Configuration specifications are set out in the simeon.ini file located in your Simeon Mail working 
directory. This file sets out whether your default login is IMSP or local .tcl, and records the name of each 
configuration option set you have stored for access during login using the Session Manager.



Drag and Drop
Drag and drop allows you to move or copy messages from one folder to another by dragging them with 
the mouse pointer and dropping into the desired folder. Drag and drop is also available in the Address 
Books and allows you to copy individuals from one book to another or copy an individual into a list.



Electronic Mail (email)
Electronic Mail is a way of sending messages to other people in your organization or around the world, 
using your computer. Electronic Mail (email) replaces normal paper copies of reports, letters, memos or 
spreadsheets with a file that has been generated on your computer.



Electronic Mail Address (Email Address)
The email address is the electronic equivalent of a regular street address that properly routes messages 
sent to any individual capable of receiving electronic mail.



Folders
A folder is a means of organizing messages received by you. There are three system-generated folders; 
inbox, receives all electronic mail messages; drafts stores a partially composed message for access at 
another time; sentmail is the default folder for saving sent messages. Additional folders can be created to 
store, archive and organize your received messages. Initially a folder contains two message groups, Main
and Deleted. Folders support drag and drop.



Helper Applications
Are used in reference to viewing attachments.    These are programs that are capable of opening an 
attachment.    Usually they will be the program that created the attachment.    



IMAP
Internet Message Access Protocol (IMAP) is the protocol used by Simeon Mail to communicate with a 
message service ensuring your mail delivery.



Mail Host
A specific Message Server (computer) responsible for storing and forwarding mail messages.



Message Groups
Message groups are intended to group electronic mail messages received by you into specific subject 
areas. Message groups contain information that will sort mail into that message group. For instance, the 
Main message group is intended to receive all incoming electronic mail messages. You may wish, 
however, to direct all messages sent by a specific person to a message group designed for their mail.



Message Headers
Message headers contain all the information regarding the current message displayed in your viewer. 
There are two types of headers: raw and short. Raw headers contain all information necessary for the 
routing of the message and includes the routing information, author, recipients, priority and error 
reporting. The short message header is formatted for easy reading and contains only the information as 
input into the envelope portion of the Compose window.



Message Service
Message services act as a receiving house for all incoming electronic mail. A message service may be 
designated to receive your regular electronic mail or act as a bulletin board service to receive mail from 
the various newsgroups you subscribe to through Usenet.



Multipart Message
A multipart message is a mail message that contains an attachment.



News Stand
News Stand is the message service that receives mail from any of the newsgroups that you subscribe to 
through Usenet.



Newsgroups
Newsgroups are the individual interest discussion groups available through Usenet. These groups are 
accessed through the News Stand message service.



Objects
Objects are any of the organizational features of Simeon Mail from the message services through folders, 
message groups and, finally, individual messages. Objects may also be an Address Book or the individual
names or lists contained therein. Objects may be classified as parent or child. A parent object might be a 
folder that contains a sub-folder. A child would be that sub-folder.



Offline
Offline refers to limited access to Simeon Mail's capabilities. Offline allows you to process your mail rather
than have full access. Any email that you have collected and stored locally on your hard drive will be 
available to process—read, reply to, forward, send.



Online
Online refers to Simeon Mail sessions where you are connected to your network and have full 
access to all configuration specifications, your full message store and all of Simeon Mail's 
capabilities.



Outbox
Outbox is the default name given to the folder that resides in your Local Folders message service and is 
used to store messages when you are offline. You may change the name of this folder, however, it must 
always reside in the Local Folders message service.



Parent Object
Any object that contains other objects within it. For instance, a folder which contains a sub-folder is 
considered the parent of that sub-folder. Sub-folder may also be parents of other sub-folders, message 
groups or messages.



PGP
Pretty Good Privacy (PGP) is a way of encrypting mail so that only a recipient will be able to decrypt and 
read it.



Properties Window
You may receive information on the properties of any object available in Simeon Mail by first selecting that
object and clicking on the Info button. The information available is dependent upon the type of object 
selected. For instance, information on a particular folder will give you the folder name, the message 
services, whether the folder is subscribed to and the number of messages contained in the folder. 
Choosing an individual in your Address Book will provide you with information on that person's email 
address, full name, and any attribute pertaining to that individual contained in the Address Book.



Quick Search
A quick and easy-to-use search facility available in Simeon Mail. Quick Searches are available for 
messages and addresses. They have limited searching capabilities looking for a keyword string with 
limited parameters.



Session Manager
The session manager is the system used to access the various configuration options created for 
online or offline access.



Subject
The subject line in the envelope section of the Compose window will contain a short description of the 
message content as input by the sender. Subject lines of forwarded messages will contain the original 
subject with a <fwd> at the end to indicate the message was forwarded. Subject lines of messages that 
are being replied to will be preceded by "Re:" followed by the original subject.



URL
A Unified Resource Link (URL) is the location on the World Wide Web where the information mentioned 
will be found. It is usually preceded by http:// (although occasionally it can be preceded by ftp//). For 
instance, to access Simeon's web page you would start your browser and type http://www.simeon.com 
in the location section. Automatic launching of URLs is available in viewer, compose, reply and forward 
windows as well as in the Public Directory.



Usenet
Usenet is not a formal organization but a collection of people who exchange articles covering a wide 
range of topics.



Viewer Window
The window that appears on your workstation when you double click to view a message or choose the 
Next or Prev buttons to view messages. Each new message brought up through the Next and Prev buttons
will show in the same Viewer. Messages viewed by double clicking will bring up a new Viewer. This will 
allow you to compare messages.




